You can find the most up-to-date technical documentation on the VMware Web site at:
http://www.vmware.com/support/
The VMware Web site also provides the latest product updates.
If you have comments about this documentation, submit your feedback to:
docfeedback@vmware.com
Contents

About This Book 7

1 Introduction to VMware vCenter Converter Standalone 9
   Migration with Converter Standalone 9
   Converter Standalone Components 10
   Cloning and System Configuration of Physical and Powered On Virtual Machines 10
      Hot Cloning of Physical and Virtual Powered On Machines 11
      Remote Hot Cloning of Powered On Source Machines That Are Running Windows 11
      Remote Hot Cloning of Powered On Source Machines That Are Running Linux 13
   Types of Data Cloning Operations 14
      Volume-Based Cloning 14
      Disk-Based Cloning 15
      Full and Linked Clones 15
   Using Converter Standalone with Virtual Machine Sources and System Images 15
   System Settings Affected by Conversion 16
   Changes to Virtual Hardware After Virtual Machine Migration 16

2 System Requirements 19
   Supported Operating Systems 19
   Supported Firmware Interfaces 20
   Supported Source Types 21
   Supported Destination Types 22
   Supported Source Disk Types 22
   Supported Destination Disk Types 24
   Support for IPv6 in Converter Standalone 25
   Installation Space Requirements 25
   Screen Resolution Requirements 26
   Configuring Permissions for vCenter Users 26
   TCP/IP and UDP Port Requirements for Conversion 26
   Requirements for Remote Hot Cloning of Windows Operating Systems 28
      Ensure that Windows Firewall Does Not Block File and Printer Sharing 28

3 Conversion Limitations 31
   Conversion Limitations for Powered On Machines 31
   Conversion Limitations for VMware Virtual Machines 31
   Limitations Related to Creating Snapshots of Windows Sources 32

4 Installing and Uninstalling Converter Standalone 33
   Perform a Local Installation on Windows 34
   Perform a Client-Server Installation in Windows 35
   Perform a Command-Line Installation in Windows 36
5 Configuring the Customer Experience Improvement Program  41
   Categories of Information That VMware Receives  41
   Join the Customer Experience Improvement Program  42

6 Convert a Physical or Virtual Machine  43
   Start the Wizard for a Conversion  44
   Select a Source Machine to Convert  44
      Select a Powered On Windows Machine to Convert  44
      Select a Powered On Linux Machine to Convert  45
      Select an ESX/ ESXi or vCenter Server Virtual Machine to Convert  46
      Select a VMware Hosted Virtual Machine to Convert  47
      Select a Hyper-V Server Virtual Machine to Convert  48
   Select a Destination for the New Virtual Machine  49
      Select a Managed Destination  49
      Select a Hosted Destination  51
   Configure the Hardware of the Destination Virtual Machine  52
      Organize the Data to Be Copied on the Destination Machine  52
      Edit the Number of Processor Sockets and Cores  62
      Allocate Memory for the Destination Virtual Machine  62
      Select a Disk Controller for the Destination Virtual Machine  63
      Configure the Network Settings of the Destination Virtual Machine  64
      Configure the Network for the Helper Virtual Machine  64
   Configure the Software on the Destination Virtual Machine  65
      Customize the Windows Guest Operating System  65
      Install VMware Tools on the Destination Virtual Machine  69
      Remove System Restore Checkpoints  69
   Configure the Conversion Job  70
      Set the Startup Mode for Destination Services  71
      Stop Services Running on the Source Machine  72
      Synchronize the Destination Machine with Changes Made to the Source Machine  72
      Power Off the Source Machine After Conversion  73
      Power On the Destination Virtual Machine After Conversion  74
      Limit the Amount of Resources Used by the Conversion Job  74
      Uninstall Converter Standalone Agent from the Source Machine  75
   Review the Summary and Submit the Conversion Job  75

7 Configure Virtual Machines  77
   Start the Configuration Wizard  77
   Select a Source Machine to Configure  78
      Select a vSphere Virtual Machine to Configure  78
      Select a VMware Desktop Virtual Machine to Configure  79
About This Book

The VMware vCenter Converter Standalone User’s Guide provides information about installing and using VMware® vCenter Converter Standalone.

Intended Audience

This book is intended for users who want to perform the following tasks:

- Install, upgrade, or use Converter Standalone
- Convert physical and virtual machines into VMware virtual machines

The material is written for information systems engineers, software developers, QA engineers, trainers, salespeople who run demonstrations, and anyone who wants to create virtual machines.

VMware Technical Publications Glossary

VMware Technical Publications provides a glossary of terms that might be unfamiliar to you. For definitions of terms as they are used in VMware technical documentation, go to http://www.vmware.com/support/pubs.

Document Feedback

VMware welcomes your suggestions for improving our documentation. If you have comments, send your feedback to docfeedback@vmware.com.

Technical Support and Education Resources

The following technical support resources are available to you. To access the current version of this book and other books, go to http://www.vmware.com/support/pubs.

Online and Telephone Support

To use online support to submit technical support requests, view your product and contract information, and register your products, go to http://www.vmware.com/support.
Customers with appropriate support contracts should use telephone support for the fastest response on priority 1 issues. Go to http://www.vmware.com/support/phone_support.html.

**Support Offerings**
To find out how VMware support offerings can help meet your business needs, go to http://www.vmware.com/support/services.

**VMware Professional Services**
VMware Education Services courses offer extensive hands-on labs, case study examples, and course materials designed to be used as on-the-job reference tools. Courses are available onsite, in the classroom, and live online. For onsite pilot programs and implementation best practices, VMware Consulting Services provides offerings to help you assess, plan, build, and manage your virtual environment. To access information about education classes, certification programs, and consulting services, go to http://www.vmware.com/services.
VMware vCenter Converter Standalone is a product to convert virtual and physical machines to VMware virtual machines. You can also configure existing virtual machines in your vCenter Server environment. Converter Standalone eases the exchange of virtual machines among the following products.

- VMware hosted products can be both conversion sources and conversion destinations.
  - VMware Workstation
  - VMware Fusion™
  - VMware Player
- Virtual machines running on an ESX or ESXi instance that vCenter Server manages can be conversion sources and the corresponding ESX, ESXi, and vCenter Server instances can be conversion destinations.
- Virtual machines running on unmanaged ESX or ESXi hosts can be conversion sources and the corresponding ESX or ESXi hosts can be conversion destinations.

This chapter includes the following topics:

- “Migration with Converter Standalone,” on page 9
- “Converter Standalone Components,” on page 10
- “Cloning and System Configuration of Physical and Powered On Virtual Machines,” on page 10
- “Types of Data Cloning Operations,” on page 14
- “Using Converter Standalone with Virtual Machine Sources and System Images,” on page 15
- “System Settings Affected by Conversion,” on page 16
- “Changes to Virtual Hardware After Virtual Machine Migration,” on page 16

**Migration with Converter Standalone**

Migration with Converter Standalone involves converting physical machines, virtual machines, and system images for use in VMware hosted and managed products.

You can convert virtual machines that vCenter Server manages for use in other VMware products. You can use Converter Standalone to perform a number of conversion tasks.

- Import running remote physical and virtual machines as virtual machines to standalone ESX/ESXi or to ESX/ESXi hosts that vCenter Server manages.
- Import virtual machines hosted by VMware Workstation or Microsoft Hyper-V Server to ESX/ESXi hosts that vCenter Server manages.
- Export virtual machines managed by vCenter Server hosts to other VMware virtual machine formats.
Configure virtual machines managed by vCenter Server so that they are bootable, and install VMware Tools or customize their guest operating systems.

- Customize guest operating systems of virtual machines in the vCenter Server inventory (for example, change the host name or network settings).
- Reduce the time needed to set up new virtual machine environments.
- Migrate legacy servers to new hardware without reinstalling operating systems or application software.
- Perform migrations across heterogeneous hardware.
- Readjust volume sizes and place volumes on separate virtual disks.

Converter Standalone Components

The Converter Standalone application consists of Converter Standalone server, Converter Standalone worker, Converter Standalone client, and Converter Standalone agent.

Converter Standalone server
Enables and performs the import and export of virtual machines. The Converter Standalone server comprises two services, Converter Standalone server and Converter Standalone worker. The Converter Standalone worker service is always installed with the Converter Standalone server service.

Converter Standalone agent
The Converter Standalone server installs the agent on Windows source machines to import them as virtual machines. You can choose to remove the Converter Standalone agent from the source machine automatically or manually after the import is complete.

Converter Standalone client
The Converter Standalone server works with the Converter Standalone client. The client component consists of the Converter Standalone user interface, which provides access to the Conversion and the Configuration wizards, and lets you to manage the conversion and the configuration tasks.

Cloning and System Configuration of Physical and Powered On Virtual Machines

When you convert a source machine, Converter Standalone uses cloning and system reconfiguration steps to create and configure the destination virtual machine so that it works successfully in vCenter Server and hosted environments. Because the migration process does not delete or modify the source, you can continue to use the original source machine after the conversion completes.

Cloning is the process of copying the source disks or volumes for the destination virtual machine. Cloning involves copying the data on the source machine’s hard disk and transferring that data to a destination virtual disk. The destination virtual disk might have a different size, file layout, and other characteristics, and thus might not be an exact copy of the source disk.

System reconfiguration adjusts the migrated operating system so that it to functions on the new virtual hardware.

If you plan to run an imported virtual machine on the same network as the source machine, you must modify the network name and IP address on one of the machines so that the source and destination machines can coexist. Besides, you must make sure that the Windows source machine and the destination virtual machine have different computer names.

**NOTE** Before converting a Windows machine, verify that you have the proper Windows license.
Hot Cloning of Physical and Virtual Powered On Machines

With Converter Standalone, you can perform hot cloning.

Hot cloning, also called live cloning or online cloning, requires converting the source machine while it is running its operating system. Hot cloning lets you clone machines without shutting them down.

Because processes continue to run on the source machine during conversion, the resulting virtual machine is not an exact copy of the source machine.

When converting Windows sources, you can set Converter Standalone to synchronize the destination virtual machine with the source machine after hot cloning. Synchronization is performed by transferring from the source to the destination the blocks that were changed during the initial cloning period. To avoid loss of data on the destination virtual machine, Converter Standalone can shut down certain Windows services before the synchronization. Based on your settings, Converter Standalone shuts down the selected Windows services so that no critical changes occur on the source machine while destination is being synchronized.

Converter Standalone can shut down the source machine and power on the destination machine when the conversion process is complete. When combined with synchronization, this action allows seamless migration of a source machine to a virtual machine destination. The destination machine takes over the source machine operations with the least possible downtime.

NOTE When you hot clone dual-boot systems, you can clone only the default operating system to which the boot.ini file or the BCD points. To clone the nondefault operating system, change the boot.ini file or the BCD to point to the other operating system and reboot. After the other operating system is booted, you can hot clone it. If your second operating system is Linux, you can boot it and clone it using the standard procedure for cloning Linux powered on source machines.

Remote Hot Cloning of Powered On Source Machines That Are Running Windows

You can use the Conversion wizard to set up conversion tasks and Converter Standalone components perform all of the cloning tasks.

The following workflow is an example of remote hot cloning in which the powered on machine being cloned experiences no downtime.

1 Converter Standalone prepares the source machine for the conversion.

Converter Standalone installs the agent on the source machine and the agent takes a snapshot of the source volumes.
2 Converter Standalone prepares the virtual machine on the destination machine.

Converter Standalone creates a virtual machine on the destination machine and the agent copies volumes from the source machine to the destination machine.

If the proxy mode feature is off, the data traffic passes from the source machine directly to the destination server.

If the proxy mode feature is on, the data traffic passes from the source machine through the Converter Standalone server to the destination server. The proxy mode feature enables conversion processes when the source machine does not have direct access to the destination ESXi server.

**NOTE** The proxy mode feature is available only for conversion of powered on Windows sources to managed destinations.

3 Converter Standalone completes the conversion process.

The agent installs the required drivers to allow the operating system to boot in a virtual machine and personalizes the virtual machine (changes the IP information, for example).

4 Optionally, Converter Standalone uninstalls the agent from the source machine.

The virtual machine is ready to run on the destination server.
Remote Hot Cloning of Powered On Source Machines That Are Running Linux

The conversion process of powered on machines that are running Linux operating systems differs from that of Windows machines.

In Windows conversions, the Converter Standalone agent is installed on the source machine and the source information is pushed to the destination.

In Linux conversions, no agent is deployed on the source machine. Instead, a helper virtual machine is created and deployed on the destination ESX/ESXi host. The source data is then copied from the source Linux machine to the helper virtual machine. After the conversion is complete, the helper virtual machine shuts down to become the destination virtual machine the next time you power it on.

Converter Standalone supports conversion of Linux sources only to managed destinations.

The following workflow demonstrates the principles of hot cloning powered on source machines that run Linux to managed destinations.

1. Converter Standalone uses SSH to connect to the source machine and retrieves source information. Converter Standalone creates an empty helper virtual machine based on your conversion task settings. The helper virtual machine serves as a container for the new virtual machine during conversion. Converter Standalone deploys the helper virtual machine on the managed destination, an ESX/ESXi host. The helper virtual machine boots from a *.iso file that is located on the Converter Standalone server machine.

2. The helper virtual machine powers on, boots from the Linux image, connects to the source machine through SSH, and starts retrieving the selected data from the source. While you set up the conversion task, you can select which source volumes to be copied to the destination machine.
3 Optionally, after data is copied, the destination virtual machine is reconfigured to allow the operating system to boot in a virtual machine.

4 Converter Standalone shuts down the helper virtual machine. The conversion process is complete.

You can configure Converter Standalone to power on the newly created virtual machine after the conversion is complete.

**Types of Data Cloning Operations**

Converter Standalone supports disk-based cloning, volume-based cloning, and linked-cloning modes.

<table>
<thead>
<tr>
<th>Cloning Modes</th>
<th>Data Copy Types</th>
<th>Application</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Volume based</td>
<td>Copy volumes from the source machine to the destination machine.</td>
<td>Volume-based cloning is relatively slow. File-level cloning is slower than block-level cloning. Dynamic disks are converted into basic volumes on the target virtual machine.</td>
<td></td>
</tr>
<tr>
<td>Disk based</td>
<td>Create copies of the powered off source machines, for all types of basic and dynamic disks.</td>
<td>You cannot select which data to copy. Disk-based cloning is faster than volume-based cloning.</td>
<td></td>
</tr>
<tr>
<td>Linked clone</td>
<td>Use to quickly check compatibility of VMware images</td>
<td>Linked cloning is the fastest (but incomplete) cloning mode that Converter Standalone supports.</td>
<td></td>
</tr>
</tbody>
</table>

**Volume-Based Cloning**

During volume-based cloning, volumes from the source machine are copied to the destination machine. Converter Standalone supports volume-based cloning during hot cloning, and during the import of existing virtual machines.

During volume-based cloning, all volumes in the destination virtual machine, except LVM2 logical volumes, are converted to basic volumes, regardless of their type in the corresponding source volume. LVM2 logical volumes can be preserved as logical volumes during conversion.

Volume-based cloning is performed at the file level or block level, depending on the destination volume size that you select.

**Volume-based cloning at the file level**

Performed when you select a size smaller than the original volume for NTFS volumes or you choose to resize a FAT volume.

For FAT, FAT32, NTFS, ext2, ext3, ext4, XFS, and ReiserFS file systems, Converter Standalone preserves the file system type during a volume-based cloning at the file level.

Dynamic source disks are read but not preserved during volume-based conversions. Dynamic disks are converted into basic volumes on the target virtual machine. Volume-based cloning of dynamic source disks at the file level is supported only for Windows.

**Volume-based cloning at the block level**

Performed when you choose to preserve the size of the source volume or when you specify a larger volume size for NTFS source volumes. Volume-based cloning at the block level is supported only for Windows.
**Disk-Based Cloning**

Converter Standalone supports disk-based cloning to import existing virtual machines.

Disk-based cloning transfers all sectors from all disks and preserves all volume metadata. The destination virtual machine receives partitions of the same type, size, and structure, as the partitions of the source virtual machine. All volumes on the source machine's partitions are copied as they are.

Disk-based cloning supports all types of basic and dynamic disks.

**Full and Linked Clones**

Clones can be full or linked depending on the amount of data copied from the source to the destination machine.

A full clone is an independent copy of a virtual machine that shares nothing with the parent virtual machine after the cloning operation. Ongoing operation of a full clone is separate from the parent virtual machine.

Because a full clone does not share virtual disks with the parent virtual machine, full clones generally perform better than linked clones. Full clones take longer to create than linked clones. Creating a full clone can take several hours or even days if the files involved are large.

You can create a full clone by using any disk clone type other than the linked clone type.

A linked clone is a copy of a virtual machine that shares virtual disks with the parent virtual machine in an ongoing manner. A linked clone is a fast way to convert and run a new virtual machine. You can create a linked clone from the current state, or snapshot, of a powered off virtual machine. This practice conserves disk space and lets multiple virtual machines use the same software installation.

All files available on the source machine at the moment of the snapshot continue to remain available to the linked clone. Ongoing changes to the virtual disk of the parent do not affect the linked clone, and changes to the disk of the linked clone do not affect the source machine. If you make changes to a source Virtual PC and Virtual Server machines, or to LiveState images, the linked clone is corrupted and cannot be used anymore.

A linked clone must have access to the source. Without access to the source, you cannot use a linked clone.

For more information about how to create a linked clone, see “Create a Linked Clone,” on page 61.

**Using Converter Standalone with Virtual Machine Sources and System Images**

With Converter Standalone, you can convert virtual machines and system images, and configure VMware virtual machines.

| Converting virtual machines | You can convert VMware virtual machines from and to Workstation, VMware Player, VMware Fusion, Hyper-V, ESX, ESXi Embedded, and ESXi Installable. You can also import virtual machines from Microsoft Virtual Server and Virtual PC. |
To be able to run an imported VMware virtual machine and its source virtual machine on the same network, you must modify the network name and IP address on one of the virtual machines. Modifying the network name and IP address lets the original and new virtual machines to coexist on the same network.

**Configuring virtual machines**

If the VMware virtual machines have disks that have been populated by using a backup of a physical host, Converter Standalone prepares the image to run on VMware virtual hardware. If you have used third-party virtualization software to create a virtual machine on an ESX host, you can use Converter Standalone to reconfigure it. You can also reconfigure any operating system installed on a multiboot machine if you have imported the virtual machine to an ESX host. Before you reconfigure a multiboot machine, you must change the `boot.ini` file or the BCD.

### System Settings Affected by Conversion

A VMware virtual machine that Converter Standalone creates contains a copy of the disk state of the source physical machine, virtual machine, or system image. Some hardware-dependent drivers and sometimes the mapped drive letters might not be preserved.

The following source computer settings remain unchanged:

- Operating system configuration (computer name, security ID, user accounts, profiles, preferences, and so on)
- Applications and data files
- Volume serial number for each disk partition

Because the target and the source virtual machines or system images have the same identities (name, SID, and so on), running them on the same network might result in conflicts. To redeploy the source virtual machine or system image, make sure that you do not run the source and target images or virtual machines on the same network at the same time.

For example, if you use Converter Standalone to test whether you can run a Virtual PC virtual machine as a VMware virtual machine without first decommissioning the original Virtual PC machine, you must first resolve the duplicate ID problem. You can resolve this problem by customizing the virtual machines in the Conversion or the Configuration wizard.

### Changes to Virtual Hardware After Virtual Machine Migration

After conversion, most applications function correctly on the VMware virtual machine because their configuration and data files have the same location as on the source virtual machine. However, applications might not work if they depend on specific characteristics of the underlying hardware, such as the serial number or the device manufacturer.

Several hardware changes might occur after you migrate a virtual machine.

**Table 1-2. Hardware Changes After Virtual Machine Migration**

<table>
<thead>
<tr>
<th>Hardware</th>
<th>Behavior</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU model and serial numbers</td>
<td>Might change after migration. They correspond to the physical computer hosting the VMware virtual machine.</td>
</tr>
<tr>
<td>Ethernet adapters</td>
<td>Might change for AMD PCNet or VMXnet and get different MAC addresses. The IP address of each interface must be individually reconfigured.</td>
</tr>
<tr>
<td>USB adapters</td>
<td>Might be updated during the cloning process.</td>
</tr>
<tr>
<td>Graphics cards</td>
<td>Might change after migration (VMware SVGA card).</td>
</tr>
</tbody>
</table>
### Table 1-2. Hardware Changes After Virtual Machine Migration (Continued)

<table>
<thead>
<tr>
<th>Hardware</th>
<th>Behavior</th>
</tr>
</thead>
<tbody>
<tr>
<td>Disks and partitions</td>
<td>The number of disks and partitions might change during the cloning process. Each disk device might have a different model and different manufacturer strings.</td>
</tr>
<tr>
<td>Primary disk controllers</td>
<td>Might differ from the source machine.</td>
</tr>
</tbody>
</table>

Applications that depend on devices that are not available within a virtual machine might not work after you migrate the virtual machine.
System Requirements

You must consider the compatibilities and the interoperabilities among the systems on which and with which the Converter Standalone components work.

This chapter includes the following topics:

- “Supported Operating Systems,” on page 19
- “Supported Firmware Interfaces,” on page 20
- “Supported Source Types,” on page 21
- “Supported Destination Types,” on page 22
- “Supported Source Disk Types,” on page 22
- “Supported Destination Disk Types,” on page 24
- “Support for IPv6 in Converter Standalone,” on page 25
- “Installation Space Requirements,” on page 25
- “Screen Resolution Requirements,” on page 26
- “Configuring Permissions for vCenter Users,” on page 26
- “TCP/IP and UDP Port Requirements for Conversion,” on page 26
- “Requirements for Remote Hot Cloning of Windows Operating Systems,” on page 28

### Supported Operating Systems

You can install Converter Standalone components only on Windows operating systems. Converter Standalone supports Windows and Linux operating systems as sources for powered-on-machine conversions and virtual-machine conversions. You cannot reconfigure Linux distributions.

<table>
<thead>
<tr>
<th>Supported Operating Systems</th>
<th>Converter Standalone Support</th>
<th>Source for Powered On Machine Conversions</th>
<th>Source for Virtual Machine Conversions</th>
<th>Configuration Source</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows Vista (32-bit and 64-bit) SP2</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Windows Server 2008 (32-bit and 64-bit) SP2</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Windows Server 2008 R2 (64-bit)</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Windows 7 (32-bit and 64-bit)</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Windows 8 (32-bit and 64-bit)</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>
### Table 2-1. Supported Operating Systems (Continued)

<table>
<thead>
<tr>
<th>Supported Operating Systems</th>
<th>Converter Standalone Support</th>
<th>Source for Powered On Machine Conversions</th>
<th>Source for Virtual Machine Conversions</th>
<th>Configuration Source</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows 8.1 (32-bit and 64-bit)</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Windows 10 (32-bit and 64-bit)</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Windows Server 2012 (64-bit)</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Windows Server 2012 R2 (64-bit)</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>CentOS 6.x (32-bit and 64-bit)</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>CentOS 7.0 (64-bit)</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Red Hat Enterprise Linux 4.x (32-bit and 64-bit)</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Red Hat Enterprise Linux 5.x (32-bit and 64-bit)</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Red Hat Enterprise Linux 6.x (32-bit and 64-bit)</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Red Hat Enterprise Linux 7.x (64-bit)</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>SUSE Linux Enterprise Server 10.x (32-bit and 64-bit)</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>SUSE Linux Enterprise Server 11.x (32-bit and 64-bit)</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Ubuntu 12.04.5 LTS (32-bit and 64-bit)</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Ubuntu 14.04 LTS (32-bit and 64-bit)</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Ubuntu 15.04 (32-bit and 64-bit)</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Ubuntu 15.10 (32-bit and 64-bit)</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
</tr>
</tbody>
</table>

### Supported Firmware Interfaces

With Converter Standalone you can perform conversions from BIOS and UEFI sources. Converter Standalone preserves the firmware interface during the conversion. You cannot convert BIOS sources to UEFI destinations and the reverse.

For UEFI sources, the supported destination types are Workstation 10.0 and later, ESXi 5.0 and later, and vCenter Server 5.0 and later.

### Table 2-2. Supported Sources Based on Operating System and Firmware Interface

<table>
<thead>
<tr>
<th>Operating System</th>
<th>BIOS</th>
<th>64-Bit UEFI</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows Vista SP2</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Windows Server 2008 SP2</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Windows Server 2008 R2</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Windows 7</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Windows 8</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Windows 8.1</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Windows 10</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>
Table 2-2. Supported Sources Based on Operating System and Firmware Interface (Continued)

<table>
<thead>
<tr>
<th>Operating System</th>
<th>BIOS</th>
<th>64-Bit UEFI</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows Server 2012</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Windows Server 2012 R2</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>CentOS 6.x</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>CentOS 7.x</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Red Hat Enterprise Linux 4.x</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Red Hat Enterprise Linux 5.x</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Red Hat Enterprise Linux 6.x</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Red Hat Enterprise Linux 7.x</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>SUSE Linux Enterprise Server 10.x</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>SUSE Linux Enterprise Server 11.x</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Ubuntu 12.04.5 LTS</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Ubuntu 14.04 LTS</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Ubuntu 15.04</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Ubuntu 15.10</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>

**Supported Source Types**

With Converter Standalone, you can convert remote powered on machines, powered off VMware virtual machines and Hyper-V Server virtual machines.

Table 2-3. Supported Sources

<table>
<thead>
<tr>
<th>Source Type</th>
<th>Sources</th>
</tr>
</thead>
<tbody>
<tr>
<td>Powered on machines</td>
<td>■ Remote Windows physical machines</td>
</tr>
<tr>
<td></td>
<td>■ Remote Linux physical machines</td>
</tr>
<tr>
<td></td>
<td>■ Local Windows physical machines</td>
</tr>
<tr>
<td></td>
<td>■ Powered on VMware virtual machines</td>
</tr>
<tr>
<td></td>
<td>■ Powered on Hyper-V Server virtual machines</td>
</tr>
<tr>
<td></td>
<td>■ Powered on virtual machines running under Red Hat KVM or RHEL XEN</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong> Converter Standalone does not support paravirtualized kernels.</td>
</tr>
<tr>
<td>VMware vCenter virtual machines</td>
<td>Powered off virtual machines managed by the following servers:</td>
</tr>
<tr>
<td></td>
<td>■ vCenter Server 4.0, 4.1, 5.0, 5.1, 5.5 and 6.0</td>
</tr>
<tr>
<td></td>
<td>■ ESX 4.0 and 4.1</td>
</tr>
<tr>
<td></td>
<td>■ ESXi 4.0, 4.1, 5.0, 5.1, 5.5 and 6.0</td>
</tr>
</tbody>
</table>
Table 2-3. Supported Sources (Continued)

<table>
<thead>
<tr>
<th>Source Type</th>
<th>Sources</th>
</tr>
</thead>
<tbody>
<tr>
<td>VMware virtual machines</td>
<td>Powered off hosted virtual machines running on the following VMware products:</td>
</tr>
<tr>
<td></td>
<td>- VMware Workstation 10.x, 11.x and 12.x</td>
</tr>
<tr>
<td></td>
<td>- VMware Fusion 6.x, 7.x and 8.x</td>
</tr>
<tr>
<td></td>
<td>- VMware Player 6.x, 7.x and 12.x</td>
</tr>
<tr>
<td>Hyper-V Server virtual</td>
<td>For Hyper-V Server versions distributed with Windows Server 2008 R2, Windows Server 2012 and Windows Server 2012 R2, powered off virtual machines with the following guest operating systems:</td>
</tr>
<tr>
<td>machines</td>
<td>- Windows Server 2003 (x86 and x64) SP1 and SP2</td>
</tr>
<tr>
<td></td>
<td>- Windows Server 2003 (x86 and x64) R2 SP1 and SP2</td>
</tr>
<tr>
<td></td>
<td>- Windows Server 2008 (x86 and x64) SP2</td>
</tr>
<tr>
<td></td>
<td>- Windows Server 2008 (x64) R2 and R2 SP1</td>
</tr>
<tr>
<td></td>
<td>- Windows Server 2012 (64-bit)</td>
</tr>
<tr>
<td></td>
<td>- Windows Server 2012 (64-bit) R2</td>
</tr>
<tr>
<td></td>
<td>- Windows 7 (except Home editions)</td>
</tr>
<tr>
<td></td>
<td>- Windows Vista SP1 and SP2 (except Home editions)</td>
</tr>
</tbody>
</table>

For other Hyper-V Server sources, perform the procedure for powered on source machines.

Supported Destination Types

With Converter Standalone, you can create virtual machines compatible with VMware hosted and managed products.

Table 2-4. Supported Destinations

<table>
<thead>
<tr>
<th>Destination Type</th>
<th>Supported Versions</th>
</tr>
</thead>
<tbody>
<tr>
<td>VMware vCenter virtual machines</td>
<td>Managed destinations</td>
</tr>
<tr>
<td></td>
<td>- ESX 4.0 and 4.1</td>
</tr>
<tr>
<td></td>
<td>- ESXi 4.0, 4.1, 5.0, 5.1, 5.5 and 6.0</td>
</tr>
<tr>
<td></td>
<td>- vCenter Server 4.0, 4.1, 5.0, 5.1, 5.5 and 6.0</td>
</tr>
<tr>
<td>VMware hosted virtual machines</td>
<td>Hosted destinations</td>
</tr>
<tr>
<td></td>
<td>- VMware Workstation 10.x, 11.x and 12.x</td>
</tr>
<tr>
<td></td>
<td>- VMware Fusion 6.x, 7.x and 8.x</td>
</tr>
<tr>
<td></td>
<td>- VMware Player 6.x, 7.x and 12.x</td>
</tr>
</tbody>
</table>

For UEFI sources, the supported destination types are Workstation 10.0 and later, ESXi 5.0 and later, and vCenter Server 5.0 and later.

Supported Source Disk Types

Converter Standalone supports conversions from master boot record (MBR) and GUID partition table (GPT) disks with some limitations that depend on the selected data cloning mode.

**Note** Converter Standalone preserves the partitioning scheme during the conversion. You cannot convert an MBR source disk to a GPT destination disk and the reverse.

Converter Standalone supports all types of basic and dynamic disks for disk-based conversions with the exception of GPT/MBR hybrid disks.
**Table 2-5. Supported and Nonsupported Source Volumes and Disks**

<table>
<thead>
<tr>
<th>Source</th>
<th>Supported Volumes and Disks</th>
<th>Nonsupported Volumes and Disks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Virtual machine</td>
<td>■ Basic volumes&lt;br&gt;■ All types of dynamic volumes&lt;br&gt;■ Master boot record (MBR) disks&lt;br&gt;■ GUID partition table (GPT) disks</td>
<td>■ RAID&lt;br&gt;■ GPT/MBR hybrid disks&lt;br&gt;■ RDM disks</td>
</tr>
<tr>
<td>Powered on machine</td>
<td>■ All types of source volumes that the operating system recognizes&lt;br&gt;■ GUID partition table (GPT) disks&lt;br&gt;■ Master boot record (MBR) disks</td>
<td>■ RAID&lt;br&gt;■ GPT/MBR hybrid disks&lt;br&gt;■ Linux volumes mounted by Device Mapper multipath</td>
</tr>
</tbody>
</table>
## Supported Destination Disk Types

Several destination disk types might be available for the selected destination.

### Table 2-6. Destination Disk Types

<table>
<thead>
<tr>
<th>Destination</th>
<th>Available Disk Types</th>
</tr>
</thead>
<tbody>
<tr>
<td>VMware vSphere virtual machine</td>
<td></td>
</tr>
<tr>
<td><strong>Thick</strong></td>
<td>Copies the entire source disk size to the destination, regardless of its used and free space.</td>
</tr>
<tr>
<td><strong>Thin</strong></td>
<td>For managed destinations that support thin provisioning through GUI, creates an expanding disk on the destination. For example, if the source disk size is 10GB, but only 3GB is used, the created destination disk is 3GB but can expand to 10GB. Managed destinations of virtual machine version 10 and later support disks up to 62TB in size. Earlier virtual machine versions support up to 2TB disks.</td>
</tr>
</tbody>
</table>

| VMware Workstation or other VMware virtual machine |  |
| **Pre-allocated** | Copies the entire source disk size to the destination, regardless of its used and free space. |
| **Not pre-allocated** | Creates an expanding disk on the destination. For example, if the source disk size is 20GB, but only 5GB is used, the created destination disk is 5GB but can expand to 20GB. Take this expansion into account when you calculate the free disk space on the destination datastore. |
| **Split pre-allocated** | For disks smaller than 2TB, splits the source disk into 2GB sections on the destination. For disks larger than 2TB, splits the source disk into 2TB sections on the destination. |
| **Split not pre-allocated** | For disks smaller than 2TB, creates 2GB sections on the destination that include only the real used space on the source disk. As the destination disk grows, new 2GB sections are created to accommodate the new data until the size reaches that of the original source disk. For disks larger than 2TB, creates 2TB sections on the destination that include only the real used space on the source disk. As the destination disk grows, new 2TB sections are created to accommodate the new data until the size reaches that of the original source disk. |
To support destination virtual disks on FAT file systems, split the source data into 2GB files.

### Support for IPv6 in Converter Standalone

Converter Standalone supports both IPv4 and IPv6 Internet protocols with several limitations.

Internet Protocol version 6 (IPv6 or IPng) is the successor to Internet Protocol version 4 (IPv4), which is the currently used protocol for assigning IP addresses to computers on the Internet. IPv6 was adopted to overcome the expected exhaustion of IPv4 addresses that might be caused by the constantly increasing number of computers on the Internet.

While IPv4 uses 32bit addresses, IPv6 uses 128bit. IPv6 addresses can have different formats or notations.

- 1040:0:0:0:0:0:0:1
- 1040::1
- 21DA:00D3:0010:2F3B:02AA:00FF:FE28:9C5A
- [2001:0db8:85a3:08d3:1319:8a2e:0370:7344]:443

Converter Standalone supports all IPv6 notations for all components of the system.

- Converter Standalone installer
- Converter Standalone client
- Converter Standalone agent
- All destinations supported in Converter Standalone

Along with the higher security level and much larger address space, IPv6 brings about some compatibility tasks that have not been resolved yet. For example, IPv4-only nodes cannot communicate directly with IPv6 nodes and need additional routing. This makes the end-to-end support of mixed IPv4 and IPv6 environments precarious.

### Installation Space Requirements

During installation, you can select the Converter Standalone components that you want to install. All components require different amounts of free disk space to install.

Table 2-7 shows the disk space required to install Converter Standalone and its components.

#### Table 2-7. Installation Space Requirements

<table>
<thead>
<tr>
<th>Installation Component</th>
<th>Disk Space Required</th>
<th>Disk Space Requirement for Decompressed Files</th>
</tr>
</thead>
<tbody>
<tr>
<td>Installation file</td>
<td>100MB</td>
<td>100MB</td>
</tr>
<tr>
<td>vCenter Converter client</td>
<td>25MB</td>
<td>25MB</td>
</tr>
<tr>
<td>vCenter Converter server</td>
<td>120MB</td>
<td>300MB</td>
</tr>
<tr>
<td>vCenter Converter agent</td>
<td>25MB</td>
<td>100MB</td>
</tr>
</tbody>
</table>
Screen Resolution Requirements

To display wizards properly, Converter Standalone requires a screen resolution of at least 1024x768 pixels.

Configuring Permissions for vCenter Users

To convert virtual machines to vCenter Server machines with Converter Standalone, you must have certain vCenter Server permissions set at the datacenter level.

To start using Converter Standalone, you need to set a number of minimum privileges at the datacenter level.

- Datastore.Allocate space
- Datastore.Browse datastore
- Host.Local operations.Create virtual machine
- Host.Local operations.Delete virtual machine
- Host.Local operations.Reconfigure virtual machine
- Network.Assign network (required only if you plan to connect the destination virtual machine to a network)
- Resource.Assign virtual machine to resource pool
- Virtual machine.Configuration
- Virtual machine.Interaction.Power On (required only if you choose to power on the destination virtual machine after conversion)
- Virtual machine.Inventory
- Virtual machine.Provisioning.Allow disk access
- Virtual machine.Provisioning.Allow read-only disk access

Converting Linux and powered on Windows machines might require a number of additional vCenter Server privileges.

- Virtual machine.Interaction.Configure CD media (required only if you need to boot a converted Linux virtual machine to install media after the conversion)
- Virtual machine.Snapshot management.Create snapshot (required only if you want to synchronize changes between the source and destination Windows virtual machine)
- Virtual machine.Snapshot management.Remove Snapshot (required only if you want to synchronize changes between the source and destination Windows virtual machine)

For more information about setting permissions, see the vSphere Datacenter Administration Guide.

TCP/IP and UDP Port Requirements for Conversion

To enable conversion, the Converter Standalone server and client must be able to send data to each other, to remote machines, and to vCenter Server. Also, the source and destination hosts must receive data from each other. Designated ports are reserved for this communication.

If any of these ports is blocked, the corresponding conversion task fails.

Ports Used When Converting a Powered On Machine Running Windows

Table 2-8 contains a list of the ports that must be open during the conversion of powered on source machines running Windows.
### Table 2-8. Ports Required During Windows P2V

<table>
<thead>
<tr>
<th>Communication Paths</th>
<th>Communication Ports</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Converter Standalone server to powered on source machine</td>
<td>TCP - 445, 139, 9089</td>
<td>If the source computer uses NetBIOS, port 445 is not required. If NetBIOS is not being used, ports 137, 138, and 139 are not required. When in doubt, make sure that none of the ports are blocked. <strong>NOTE</strong>: Unless you have installed Converter Standalone server or agent on the source computer, the account used for authentication to the source computer must have a password, network file sharing must be enabled on the source computer, and Simple File Sharing must not be used.</td>
</tr>
<tr>
<td>Converter Standalone server to vCenter Server</td>
<td>TCP - 443</td>
<td>Required only if the conversion destination is a vCenter Server.</td>
</tr>
<tr>
<td>Converter Standalone client to Converter Standalone server</td>
<td>TCP - 443</td>
<td>Required only if the Converter Standalone server and client components are on different machines.</td>
</tr>
<tr>
<td>Converter Standalone server to the destination ESX/ESXi</td>
<td>TCP - 902</td>
<td>Converter server always requires access to ESX/ESXi at port 902.</td>
</tr>
<tr>
<td>Powered on source machine to ESX/ESXi</td>
<td>TCP - 443, 902</td>
<td>If the conversion destination is vCenter Server, only port 902 is required. If the proxy mode feature is on, port 902 is not required.</td>
</tr>
</tbody>
</table>

### Ports Used When Converting a Powered On Machine Running Linux

Table 2-9 contains a list of the ports that must be open during the conversion of powered on source machines running Linux.

### Table 2-9. Ports Required During Linux P2V

<table>
<thead>
<tr>
<th>Communication Paths</th>
<th>TCP Ports</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Converter Standalone server to powered on source machine</td>
<td>22</td>
<td>Used to establish an SSH connection between the Converter Standalone server and the source machine.</td>
</tr>
<tr>
<td>Converter Standalone client to Converter Standalone server</td>
<td>443</td>
<td>Required only if the Converter Standalone server and client components are on different machines.</td>
</tr>
<tr>
<td>Converter Standalone server to vCenter Server</td>
<td>443</td>
<td>Required only if the conversion destination is a vCenter Server.</td>
</tr>
<tr>
<td>Converter Standalone server to ESX/ESXi</td>
<td>443, 902</td>
<td>If the conversion destination is a vCenter Server, only port 902 is required.</td>
</tr>
<tr>
<td>Converter Standalone server to helper virtual machine</td>
<td>443</td>
<td>Used to establish an SSH connection between the helper virtual machine and the source machine. By default, the IP address of the helper virtual machine is assigned by DHCP. If no DHCP server is available on the destination network, you must manually assign the helper virtual machine an IP address.</td>
</tr>
</tbody>
</table>

### Ports Used When Converting Virtual Machine Sources

Table 2-10 contains a list of the ports that must be open during the conversion of virtual machines.
Table 2-10. Ports Required During V2V Communication Paths

<table>
<thead>
<tr>
<th>Communication Paths</th>
<th>Communication Ports</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Converter Standalone server to Fileshare path</td>
<td>TCP - 445, 139</td>
<td>Required only for standalone virtual machine sources or destinations. If the computer hosting the source or destination path uses NetBIOS, port 445 is not required. If NetBIOS is not being used, ports 137, 138, and 139 are not required. When in doubt, make sure that none of the ports are blocked.</td>
</tr>
<tr>
<td></td>
<td>UPD - 137, 138</td>
<td></td>
</tr>
<tr>
<td>Converter Standalone client to Converter Standalone server</td>
<td>TCP - 443</td>
<td>Required only if the Converter Standalone server and client components are on different machines.</td>
</tr>
<tr>
<td>Converter Standalone server to vCenter Server</td>
<td>TCP - 443</td>
<td>Required only if the conversion destination is a vCenter Server.</td>
</tr>
<tr>
<td>Converter Standalone server to ESX/ESXi</td>
<td>TCP - 443, 902</td>
<td>If the conversion destination is a vCenter Server, only port 902 is required.</td>
</tr>
</tbody>
</table>

Requirements for Remote Hot Cloning of Windows Operating Systems

To avoid problems related to permissions and network access, ensure that simple file sharing is turned off and that Windows Firewall does not block file and printer sharing. Also, to access file and printer sharing ports, you might need to change the scope of the IP addresses that the firewall allows.

To ensure successful remote hot cloning of Windows platforms, verify the following conditions on the source machine before you start the application:

- Ensure that simple file sharing is turned off.
- Ensure that file and printer sharing is not blocked by Windows Firewall.

You must allow incoming file share connections in the following situations:

- When you use the machine to host standalone images
- When you use the machine as a standalone destination
- When you hot clone the machine remotely

For Windows Vista and later, you must either use an administrator account for Converter Standalone when logging to the source machine, or disable UAC on the source machine.

To enable customization of the guest operating system, install Sysprep files on the machine where Converter Standalone server runs.

Ensure that Windows Firewall Does Not Block File and Printer Sharing

If Converter Standalone fails to connect to a remote Windows machine and issues a bad username/password error message, ensure that file and printer sharing is not blocked by Windows Firewall.

Procedure

1. Select **Start > Settings > Control Panel > Administrative Tools > Local Security Policy.**
2. In the Security Settings list on the left, select **Local Policies > Security Options.**
3. In the policies list on the right, select **Network access: Sharing and Security model for local accounts.**
4. Verify that **Classic – local users authenticate as themselves** is selected.
What to do next

For troubleshooting information about file and printer sharing, search the Microsoft TechNet Web site.

For information about setting file and printer sharing on other Windows systems, see the documentation for your system.
Conversion Limitations

When you are aware of the conversion limitations of Converter Standalone, you might be able to avoid conversion and post-conversion problems, and handle them more easily.

This chapter includes the following topics:

- “Conversion Limitations for Powered On Machines,” on page 31
- “Conversion Limitations for VMware Virtual Machines,” on page 31
- “Limitations Related to Creating Snapshots of Windows Sources,” on page 32

Conversion Limitations for Powered On Machines

When you convert a powered on machine, some conversion features might not be available for certain source operating systems.

Table 3-1. Limitations for Powered On Machine Conversion

<table>
<thead>
<tr>
<th>Source Operating System</th>
<th>Limitations</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows</td>
<td>- When you convert UEFI sources, Converter Standalone does not copy any UEFI variables to the destination.</td>
</tr>
<tr>
<td></td>
<td>- Synchronization is supported only for volume-based cloning at the block level.</td>
</tr>
<tr>
<td>Linux</td>
<td>- Only volume-based cloning at the file level is supported.</td>
</tr>
<tr>
<td></td>
<td>- Only managed destinations are supported.</td>
</tr>
<tr>
<td></td>
<td>- Converting multiboot virtual machines is supported only if GRUB is installed as the boot loader. LILO is not supported.</td>
</tr>
<tr>
<td></td>
<td>- When you convert UEFI sources, Converter Standalone copies only the current UEFI boot entry option to the destination.</td>
</tr>
<tr>
<td></td>
<td>- Simultaneous cloning of multiple disks and volumes is supported only when converting a virtual Linux source.</td>
</tr>
<tr>
<td></td>
<td>- Installing VMware Tools on Linux guest operating systems is not supported.</td>
</tr>
</tbody>
</table>

Conversion Limitations for VMware Virtual Machines

Certain limitations exist when you convert a VMware virtual machine.

You must power off source virtual machines before you convert them. You can convert running virtual machines if you follow the procedure for converting powered on machines.

For volume-based conversions of virtual machine sources that run Windows 8 or Windows Server 2012, Converter Standalone does not preserve storage pools on the destination.

For volume-based conversions of UEFI sources, Converter Standalone does not preserve the UEFI settings. The UEFI settings are preserved during disk-based conversions.
When you convert a virtual machine with snapshots, the snapshots are not transferred to the destination virtual machine.

For volume-based conversions of powered-off virtual machine sources at file level, the Converter Standalone server host operating system must support the file system of the source volume. For example, when the Converter Standalone is running on Windows Server 2008, you cannot convert source volumes with ReFS.

Certain limitations are applicable when you convert Linux virtual machine sources.

- Only disk-based cloning is supported for Linux guest operating systems.
- Configuration or customization is not supported for Linux guest operating systems.
- Installing VMware Tools is not supported on Linux guest operating systems.

### Limitations Related to Creating Snapshots of Windows Sources

Converter Standalone uses VSS snapshots to save the state of source volumes during hot cloning of physical and virtual machines that run Windows. VSS snapshots are also used to synchronize the destination virtual machine with the source machine after the initial conversion. Some of the VSS-related issues are inherited in Converter Standalone and can prevent the proper completion of your conversion tasks.

Read the limitations listed in Table 3-2 before you initiate a conversion task.

If your conversion task fails with a VSS-related error message, you can check the table for possible reasons and workarounds.

<table>
<thead>
<tr>
<th>VSS Limitations</th>
<th>Error Messages</th>
<th>Workarounds</th>
</tr>
</thead>
<tbody>
<tr>
<td>For all operating systems that support volume-based cloning, you need at least one NTFS volume for VSS to work.</td>
<td></td>
<td>There is no workaround for this limitation.</td>
</tr>
<tr>
<td>VSS under Windows Vista and later does not support FAT and FAT32.</td>
<td>Failed to create VSS snapshot of source volume. Error code: 2147754764 (0x8004230C)</td>
<td>Deselect all FAT and FAT32 volumes on the View/Edit Options page of the vCenter Converter wizards.</td>
</tr>
<tr>
<td>VSS under Windows Server 2008 does not support unformatted or unrecognized volumes.</td>
<td>Failed to create VSS snapshot of source volume. Error code: 2147754783 (0x8004231F)</td>
<td>Format all unformatted or unrecognized volumes and try the conversion again. Deselect all unformatted or unrecognized volumes while setting up the conversion task in the Data to copy pane of the View/Edit Options page.</td>
</tr>
<tr>
<td>If the space in the VSS snapshot storage area is not enough for VSS to create a snapshot, the conversion fails.</td>
<td>Failed to create VSS snapshot of source volume. Error code: 2147754783 (0x8004231F)</td>
<td>Clean up the source volumes, especially the system volume and all NTFS volumes, and try to convert the source again.</td>
</tr>
</tbody>
</table>
| Importing powered-on Hyper-V sources fails if the following two VSS services are not started or are not operating properly on the source machine: | Failed to create VSS snapshot of source volume. Error code: 2147754758 (0x80042306) | 1 Set the starting mode for Microsoft Software Shadow Copy Provider Service and Volume Shadow Copy Service to Automatic.  
2 Restart the source machine and try cloning it again. |
You can install Converter Standalone on a physical or a virtual machine. You can also modify or repair a Converter Standalone installation.

The Local setup installs the Converter Standalone server, Converter Standalone agent, and Converter Standalone client for local use.

**Note** Local installation of Converter Standalone complies with the following security restrictions:

- After the initial setup, the use of an administrator account requires physical access to the product.
- You can manage Converter Standalone only from the machine where it is installed.

During the client-server installation, you can select the Converter Standalone components that you want to install on your system. You can also choose to join the Customer Experience Improvement Program. See Chapter 5, “Configuring the Customer Experience Improvement Program,” on page 41.

When you install the Converter Standalone server and Remote access, the local machine becomes a server for conversions, which you can manage remotely. When you install the Converter Standalone server and the Converter Standalone client, you can use the local machine to access remote Converter Standalone servers or create conversion jobs locally.

If you install only Converter Standalone client, you can connect to a remote Converter Standalone server. You can then use the remote machine to convert hosted virtual machines, managed virtual machines, or remote physical machines.

This chapter includes the following topics:

- “Perform a Local Installation on Windows,” on page 34
- “Perform a Client-Server Installation in Windows,” on page 35
- “Perform a Command-Line Installation in Windows,” on page 36
- “Command-Line Options for Windows Installation,” on page 37
- “Modify Converter Standalone in Windows,” on page 37
- “Repair Converter Standalone in Windows,” on page 38
- “Uninstall Converter Standalone in Windows,” on page 39
- “Connect to a Remote Converter Standalone Server,” on page 39
- “Enable SSLv3 Protocol in vCenter Converter Standalone,” on page 40
Perform a Local Installation on Windows

You can install Converter Standalone on a physical or a virtual machine. The local setup installs the Converter Standalone server, Converter Standalone agent, and Converter Standalone client for local use.

If you install Converter Standalone in local mode, you can create and manage conversion tasks only from the machine on which you installed the application. During the installation you can choose to join the Customer Experience Improvement Program. See Chapter 5, “Configuring the Customer Experience Improvement Program,” on page 41.

Prerequisites

Verify that your system meets the Converter Standalone system requirements.
Verify that you have Administrator privileges.
If you have Converter 3.0.x installed and your machine runs Windows Vista, uninstall Converter 3.0.x manually before you install Converter Standalone 6.1.
If you have an earlier version of Converter Standalone agent on the system, uninstall Converter Standalone agent.

Procedure

1. Download the latest version of Converter Standalone from the VMware Web site.
2. In the folder that contains the installer file you downloaded, double-click the `VMware-converter-6.1.x-<xxxxx>.exe` file, where `<xxxxx>` is the number of the build.
3. Follow the prompts till the End-User License Agreement page appears.
4. Select I agree to the terms in the License agreement and click Next.
5. On the Destination Folder page, select the location to install Converter Standalone and click Next.
6. On the Setup Type page, select Local installation and click Next.
7. (Optional) On the User Experience Setting page, you can select the check box to join the Customer Experience Improvement Program, and click Next.

   **NOTE** If you do not want to join the Customer Experience Improvement Program, deselect the check box instead.

8. On the Ready to Install page, click Install.
9. (Optional) On the Installation Completed page, deselect Run VMware vCenter Converter Standalone Client now if you want to start the application later.

   A prompt might ask you to restart your system.

Converter Standalone is installed on the local machine and is ready for use.

What to do next

You can use Converter Standalone to convert physical or virtual machine sources to virtual machine destinations.
Perform a Client-Server Installation in Windows

Perform a client-server installation so that you can create and manage conversion tasks remotely.

During the client-server installation, you can select the Converter Standalone components that you want to install on your system. You can also choose to join the Customer Experience Improvement Program. See Chapter 5, “Configuring the Customer Experience Improvement Program,” on page 41

Prerequisites

Verify that your system meets the Converter Standalone system requirements.

Verify that you have Administrator privileges.

If you have Converter 3.0.x installed and your machine runs Windows Vista, uninstall Converter 3.0.x manually before you install Converter Standalone 6.1.

If you have an earlier version of Converter Standalone agent on the system, uninstall Converter Standalone agent.

Procedure

1. Download the latest version of Converter Standalone from the VMware Web site.
2. In the folder that contains the installer file you downloaded, double-click the `VMware-converter-6.1.x-<xxxxx>.exe` file, where `<xxxxx>` is the number of the build.
3. Follow the prompts till the End-User License Agreement page appears.
4. Select I agree to the terms in the License agreement and click Next.
5. On the Destination Folder page, select the location to install Converter Standalone and click Next. The default location is `C:\Program Files\VMware\VMware vCenter Converter Standalone`.
6. On the Setup Type page, select Client-Server installation (advanced) and click Next.
7. On the Custom Setup page, select the components that you want to install and click Next.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Converter server</td>
<td>Converter Standalone server manages the conversion tasks. It handles the communication between the Converter Standalone clients and Converter Standalone agents. You cannot install Converter server alone. You must install Converter Standalone server together with Remote access or with the Converter Standalone client, or with both.</td>
</tr>
<tr>
<td>Remote access</td>
<td>If you install Remote access, local and multiple remote Converter Standalone clients can connect to the local Converter Standalone server. With Remote access you can create and manage conversion tasks remotely. For remote access, you must perform a client-server installation.</td>
</tr>
<tr>
<td>Converter agent</td>
<td>Install Converter Standalone agent so that the local machine can be a source machine for conversions.</td>
</tr>
<tr>
<td>Converter client</td>
<td>If you install only Converter Standalone client, you can connect to a remote Converter Standalone server. You can then use the remote machine to convert hosted virtual machines, managed virtual machines, or remote physical machines.</td>
</tr>
</tbody>
</table>

When you install the Converter Standalone server and Remote access, the local machine becomes a server for conversions, which you can manage remotely. When you install the Converter Standalone server and the Converter Standalone client, you can use the local machine to access remote Converter Standalone servers or create conversion jobs locally.
8 (Optional) If you decided to install Remote access or Converter Standalone agent, modify the Web service ports on the Port Settings page.

- Type the HTTPS port service number.
- Type the HTTP port service number.
- Type the Agent port service number.

9 (Optional) On the User Experience Setting page, you can select the check box to join the Customer Experience Improvement Program, and click Next.

**Note** If you do not want to join the Customer Experience Improvement Program, deselect the check box instead.

10 On the Ready to Install page, click Install.

11 (Optional) If you installed the Converter Standalone client, deselect Run Converter Standalone Client now to complete the installation without starting the application at this time.

12 On the Installation Completed page, click Finish.

A prompt might ask you to restart your system.

The selected Converter Standalone components are installed on the local machine and are ready for use.

**What to do next**

You can use Converter Standalone to convert physical or virtual machine sources to virtual machine destinations.

**Perform a Command-Line Installation in Windows**

You can install Converter Standalone from the MS-DOS command prompt or by writing a Windows batch file (.bat) to automate the installation process.

**Prerequisites**

Verify that your system meets the Converter Standalone system requirements.

Verify that you have Administrator privileges.

If you have Converter 3.0.x installed and your machine runs Windows Vista, uninstall Converter 3.0.x manually before you install Converter Standalone 6.1.

If you have an earlier version of Converter Standalone agent on the system, uninstall Converter Standalone agent.

**Procedure**

1. Download the latest version of Converter Standalone from the VMware Web site.
2. Open an MS-DOS command prompt window.
3. At the command line, navigate to the local directory to which you downloaded the installer.
4. To install Converter Standalone silently with the log file written to the temp directory, enter:

   ```
   VMware-converter-6.1.x-<build>.exe /s /v"/qn ADDLOCAL=ALL /l*v %TEMP%\vmconvservermsi.log"
   ```

   where `VMware-converter-6.1.x-<build>.exe` is the full installer filename.

   For more command-line options, see “Command-Line Options for Windows Installation,” on page 37.
What to do next

You can use Converter Standalone to convert physical or virtual machine sources to virtual machine destinations.

Command-Line Options for Windows Installation

You can use the command-line installation options when you install Converter Standalone from the MS-DOS command prompt in Windows or by writing a Windows batch file (.bat).

For a list of options to perform command-line installation, see Table 4-1.

Table 4-1. Command-Line Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>/s</td>
<td>Does not display the Windows Installer version check.</td>
</tr>
<tr>
<td>/v&quot;params&quot;</td>
<td>Passes parameters to the msiexec.exe file.</td>
</tr>
<tr>
<td>/qn</td>
<td>Runs the msi command in silent mode.</td>
</tr>
<tr>
<td>/qb</td>
<td>Runs the msi command in basic mode.</td>
</tr>
<tr>
<td>/qf</td>
<td>Runs the msi command in full mode.</td>
</tr>
<tr>
<td>/l*v Logfile</td>
<td>Records login information in the file provided in Logfile.</td>
</tr>
<tr>
<td>/x</td>
<td>Uninstalls VMware vCenter Converter Standalone.</td>
</tr>
<tr>
<td>ADDLOCAL=&quot;ALL&quot;</td>
<td>Installs full package. The parameter is case-sensitive.</td>
</tr>
<tr>
<td>PROPERTY=property value</td>
<td>Sets the value of a property to property value.</td>
</tr>
<tr>
<td>VMCE_HTTP_PORT</td>
<td>Sets the HTTP port. The default is 80. Remote machines connect to the server through this port to download the Converter Standalone client.</td>
</tr>
<tr>
<td>VMCE_HTTPS_PORT</td>
<td>Set the HTTPS port. The default is 443. Remote Converter Standalone clients connect to this port on the server and submit conversion tasks.</td>
</tr>
<tr>
<td>VMCE_AGENT_PORT</td>
<td>Sets an Agent port. The default is 9089. Remote Converter Standalone servers connect to this port to convert this machine.</td>
</tr>
</tbody>
</table>

Modify Converter Standalone in Windows

To change the installed Converter Standalone agent or the communication ports for the Converter Standalone components, you must modify the Converter Standalone installation.

Prerequisites

Verify that you have Administrator privileges.

Close the Converter Standalone application before you start the installer wizard.

Procedure

1. To start the Converter Standalone installer, perform one of the following actions:
   - Go to the folder that contains the installer file and double-click the VMware-converter-6.1.x-<xxxxx>.exe file, where <xxxxx> is the number of the build. Check the number of the build to see if it matches the build you installed.
   - Select Add or Remove Programs from Control Panel, select Converter Standalone from the list, and click Change.
2 On the Welcome page of the installer wizard, click Next.

3 On the Program Maintenance page, select Modify and click Next.

4 On the Custom Setup page, select the components that you want to install and click Next.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Converter server</td>
<td>Converter Standalone server manages the conversion tasks. It handles the communication between the Converter Standalone clients and Converter Standalone agents. You cannot install Converter server alone. You must install Converter Standalone server together with Remote access or with the Converter Standalone client, or with both.</td>
</tr>
<tr>
<td>Remote access</td>
<td>If you install Remote access, local and multiple remote Converter Standalone clients can connect to the local Converter Standalone server. With Remote access you can create and manage conversion tasks remotely. For remote access, you must perform a client-server installation.</td>
</tr>
<tr>
<td>Converter agent</td>
<td>Install Converter Standalone agent so that the local machine can be a source machine for conversions.</td>
</tr>
<tr>
<td>Converter client</td>
<td>If you install only Converter Standalone client, you can connect to a remote Converter Standalone server. You can then use the remote machine to convert hosted virtual machines, managed virtual machines, or remote physical machines.</td>
</tr>
</tbody>
</table>

When you install the Converter Standalone server and Remote access, the local machine becomes a server for conversions, which you can manage remotely. When you install the Converter Standalone server and the Converter Standalone client, you can use the local machine to access remote Converter Standalone servers or create conversion jobs locally.

5 (Optional) If you decided to install Remote access or Converter Standalone agent, modify the Web service ports on the Port Settings page.
   - Type the HTTPS port service number.
   - Type the HTTP port service number.
   - Type the Agent port service number.

6 On the Ready to Modify page, click Install.

7 (Optional) If you installed the Converter Standalone client, deselect Run Converter Standalone Client now to complete the installation without starting the application at this time.

8 On the Installation Completed page, click Finish.
   
   A prompt might ask you to restart your system.

The selected Converter Standalone components are installed on the local machine and are ready for use.

**What to do next**

You can use Converter Standalone to convert physical or virtual machine sources to virtual machine destinations.

**Repair Converter Standalone in Windows**

You can repair the Converter Standalone installation to check for and reinstall the Converter Standalone client or Converter Standalone agent.

**Prerequisites**

Verify that you have Administrator privileges.

Close the Converter Standalone application before you start the installer wizard.
Procedure

1. To start the Converter Standalone installer, perform one of the following actions:
   - Go to the folder that contains the installer file and double-click the `VMware-converter-6.1.x-<xxxxx>.exe` file, where `<xxxxx>` is the number of the build. Check the number of the build to see if it matches the build you installed.
   - Select Add or Remove Programs from Control Panel, select Converter Standalone from the list, and click Change.

2. On the Welcome page of the installer wizard, click Next.

3. On the Program Maintenance page, select Repair and click Next.

4. On the Ready to Repair page, click Install.

5. On the Installation Completed page, click Finish.
   A prompt might ask you to restart your system.

What to do next

You can use Converter Standalone to convert physical or virtual machine sources to virtual machine destinations.

Uninstall Converter Standalone in Windows

You can uninstall Converter Standalone by using the Microsoft Windows Add or Remove Programs utility from the Control Panel or by using the VMware vCenter Converter Standalone installer wizard.

Prerequisites

Verify that you have Administrator privileges.

Close the Converter Standalone application before you start the installer wizard.

Procedure

1. To start the Converter Standalone installer, perform one of the following actions:
   - Go to the folder that contains the installer file and double-click the `VMware-converter-6.1.x-<xxxxx>.exe` file, where `<xxxxx>` is the number of the build. Check the number of the build to see if it matches the build you installed.
   - Select Add or Remove Programs from Control Panel, select Converter Standalone from the list, and click Change.

2. On the Welcome page of the installer wizard, click Next.

3. On the Program Maintenance page, select Remove and click Next.

4. On the Ready to Remove page, click Remove.

5. On the Installation Completed page, click Finish.
   A prompt might ask you to restart your system.

Connect to a Remote Converter Standalone Server

You can use the Converter Standalone client to connect to a Converter Standalone server installed on a remote machine.

Prerequisites

Ensure that the Converter Standalone server and agent are installed on the remote machine.
Procedure

1. Start Converter Standalone.
2. Follow the procedure that is applicable for your installation type.

<table>
<thead>
<tr>
<th>Option</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Local installation</td>
<td>a. Select Administration &gt; Connect to another server.</td>
</tr>
<tr>
<td></td>
<td>b. On the Converter Standalone login page, select Enter the IP address or host name of the Converter Standalone server.</td>
</tr>
<tr>
<td></td>
<td>c. Provide the IP address and Administrator credentials, and click Login.</td>
</tr>
<tr>
<td>Client-server installation with remote access</td>
<td>a. On the Converter Standalone login page, select Enter the IP address or host name of the Converter Standalone server.</td>
</tr>
<tr>
<td></td>
<td>b. Provide the IP address and Administrator credentials, and click Login.</td>
</tr>
</tbody>
</table>

What to do next

You can now use the remote Converter Standalone server to set up and manage conversion tasks.

Enable SSLv3 Protocol in vCenter Converter Standalone

You can enable the SSLv3 protocol manually.

By default, vCenter Converter Standalone uses TLS 1.0, TLS 1.1, and TLS 1.2 security protocols. SSLv2 and SSLv3 security protocols are disabled. You can enable the SSLv3 protocol manually.

Procedure

1. Navigate to %ALLUSERSPROFILE%\VMware\VMware vCenter Converter Standalone\ and open the converter-server.xml, converter-worker.xml, and converter-agent.xml files in a text editor.
2. Locate the <sslOptions> tag and change its value from 50479104 to 16924672.

   **Note** Changing the value to 117587968 disables SSLv3 and TLS 1.0.
3. Save the changes to the files.
4. Restart the services for the changes to take effect.

   **Note** If you install Converter Agent on a remote machine, you must repeat this procedure by using the converter-agent.xml file on the remote machine.
When you choose to participate in the Customer Experience Improvement Program (CEIP), VMware receives anonymous information to improve the quality, reliability, and functionality of VMware products and services.

This chapter includes the following topics:

- “Categories of Information That VMware Receives,” on page 41
- “Join the Customer Experience Improvement Program,” on page 42

Categories of Information That VMware Receives

The Customer Experience Improvement Program (CEIP) provides VMware with information that enables VMware to improve the VMware products and services and to fix problems. When you choose to participate in CEIP, VMware will collect the technical information that is listed below about your use of the VMware products and services in CEIP reports on a regular basis. This information does not personally identify you.

Information that VMware receives through the CEIP contains the following categories:

**Configuration Data**

Data about how you have configured VMware products and services and related environment information. Examples of Configuration Data include version information for VMware products, product environment information, and product configuration settings. Configuration Data may include obfuscated versions of your device IDs and MAC and Internet Protocol addresses.

**Feature Usage Data**

Data about how you use VMware products and services. Examples of Feature Usage Data include details about which product features you use and metrics of user interface activity.

**Performance Data**

Data about the performance of VMware products and services. Examples of Performance Data include metrics of the performance and scale of VMware products and services, response times for user interfaces, and details about your API calls.

VMware collects the above CEIP reporting information in connection with a unique CEIP instance identifier that is stored on your device and which does not personally identify you. This identifier enables VMware to distinguish one report from another.
Join the Customer Experience Improvement Program

You can choose to join the Customer Experience Improvement Program (CEIP), or leave the CEIP at any time.

**Note** You can join the CEIP during the installation of Converter Standalone.

**Procedure**

1. From the **Administration** menu on the toolbar, select **Customer Experience Improvement Program**.
2. Select the check box to enable CEIP or deselect the check box to disable the program and then click **OK**.
Convert a Physical or Virtual Machine

You can create a conversion job to convert a physical or virtual machine to a variety of destinations. You can convert powered on physical machines, VMware virtual machines, and Hyper-V Server virtual machines into VMware standalone virtual machines or virtual machines that vCenter Server manages.

The approach you take for creating the conversion job is determined by the type of source and the type of destination that you select.

**Source type**
A powered on physical or virtual machine, a vSphere virtual machine running on an ESX/ESXi host, or a standalone virtual machine.

Standalone virtual machines include VMware virtual machines, such as VMware Workstation.

For a complete list of supported source types and product versions, see “Supported Source Types,” on page 21.

**Destination type**
ESX/ESXi host, ESX/ESXi host that vCenter Server manages, or a VMware standalone virtual machine.

For a complete list of supported destination types and product versions, see “Supported Destination Types,” on page 22.

**Procedure**

1. **Start the Wizard for a Conversion** on page 44
   The Conversion wizard guides you through the steps of creating a conversion job.

2. **Select a Source Machine to Convert** on page 44
   You can select from several source options for the type of machine to convert.

3. **Select a Destination for the New Virtual Machine** on page 49
   When you set up a conversion job, you must select a destination for the new virtual machine.

4. **Configure the Hardware of the Destination Virtual Machine** on page 52
   You can configure the virtual hardware resources that the destination virtual machine uses.

5. **Configure the Software on the Destination Virtual Machine** on page 65
   You can configure the guest operating system so that it is ready to operate in a virtual environment.

6. **Configure the Conversion Job** on page 70
   You can configure the conversion process and select the behavior of the source and destination machine during and after conversion. You can change the status of the source and destination services only when the source machine is running a Windows operating system.
7 Review the Summary and Submit the Conversion Job on page 75
On the Summary page, you can view a summary of the conversion job before you add it to the job list.

Start the Wizard for a Conversion
The Conversion wizard guides you through the steps of creating a conversion job.

Procedure
1 Start the Converter Standalone application.
2 Click **Convert machine** in the application menu.

The Conversion wizard opens on the Source System page.

What to do next
You can now select the source machine type to convert.

Select a Source Machine to Convert
You can select from several source options for the type of machine to convert.

Prerequisites
Before you select a source machine to convert, verify that it is listed in the list of supported source types. See “Supported Source Types,” on page 21.

- **Select a Powered On Windows Machine to Convert** on page 44
  You can select a running (powered on) Windows machine to convert. The source machine can be physical or virtual.

- **Select a Powered On Linux Machine to Convert** on page 45
  You can select a powered on Linux machine to convert. The source machine can be a physical or virtual machine.

- **Select an ESX/ESXi or vCenter Server Virtual Machine to Convert** on page 46
  You can convert a powered off virtual machine that is located on an ESX/ESXi host, or on an ESX/ESXi host managed by vCenter Server.

- **Select a VMware Hosted Virtual Machine to Convert** on page 47
  You can convert a virtual machine created or used in a VMware hosted product, such as VMware Workstation, VMware Player, and VMware Fusion.

- **Select a Hyper-V Server Virtual Machine to Convert** on page 48
  You can convert virtual machines that Hyper-V Server manages.

Select a Powered On Windows Machine to Convert
You can select a running (powered on) Windows machine to convert. The source machine can be physical or virtual.

Prerequisites
Before you continue, you must prepare the source Windows machine for conversion.

- Make sure that the Windows version installed on the powered on machine is supported. For a list of supported operating systems, see “Supported Operating Systems,” on page 19.
- Make sure that the Converter Standalone server machine has network access to the Windows source machine.
- Turn off firewall applications running on the source machine.
- Disable simple file sharing on the source Windows machine.
- Stop or disable anti-virus software running on the source machine.
- Turn off UAC or use local Administrator account on the source machine.
- Make sure that no other conversion job is using the source you select.
- Remove any VMware Converter 4.x and VMware Converter 5.x installations manually from the source machine.

**Procedure**

1. On the Source System page of the Conversion wizard, select the **Powered on** radio button.
2. From the drop-down menu, select an option that corresponds to your source machine location.

<table>
<thead>
<tr>
<th>Source Location</th>
<th>Action</th>
</tr>
</thead>
</table>
| **Local**       | Click This local machine.  
For local machines, the authorization is set to the current user and cannot be changed. If you connect to Converter Standalone server by IP address, Connect this local machine option is not active. Convert the local machine like a remote machine. |
| **Remote**      | a) Click Remote Windows machine.  
b) Provide the IP address or name of the machine and administrator credentials. |

3. (Optional) Click View source details to see hardware and software information about the source machine.
4. Click Next.
   
   If you convert a remote machine and Converter Standalone agent is not already installed on the source machine, a dialog box prompts you to confirm the installation and select an uninstallation method for Converter Standalone agent.
5. (Optional) Select the uninstallation procedure for Converter Standalone agent and click Yes.

   Converter Standalone agent is installed on the source machine.

   Converter Standalone agent prepares the source machine for conversion.

**What to do next**

On the Destination System page, you can select the destination type for the new virtual machine.

**Select a Powered On Linux Machine to Convert**

You can select a powered on Linux machine to convert. The source machine can be a physical or virtual machine.

You can convert powered on machines that run Linux only if GRUB is installed as the boot loader on the source. LILO boot loader is not supported.

**Prerequisites**

Before you continue, you must prepare the source machine for conversion.

- Enable SSH on the source Linux machine.
- Make sure that you use the root account or account with sudo privileges for all commands to convert a Linux powered on machine.
Make sure that the Converter Standalone server machine has network access to the Linux source machine.

Make sure that no other conversion job is using the source you select.

**Procedure**

1. On the Source System page of the Conversion wizard, select the **Powered on** radio button.
2. Select **Remote Linux machine** from the drop down menu.
3. Provide the IP address or DNS name and select authentication method. Provide the IP address or DNS name and root credentials for the Linux machine you want to convert.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Password</td>
<td>Enter the root credentials for the Linux machine you want to convert.</td>
</tr>
<tr>
<td>Private key file</td>
<td>Select the private key file and enter the passphrase.</td>
</tr>
</tbody>
</table>

4. Click Next.

Converter Standalone connects to the powered on Linux machine and prepares it for conversion.

**What to do next**

On the Destination System page, you can select the destination type for the new virtual machine.

**Select an ESX/ ESXi or vCenter Server Virtual Machine to Convert**

You can convert a powered off virtual machine that is located on an ESX/ESXi host, or on an ESX/ESXi host managed by vCenter Server.

You cannot convert a running or suspended virtual machine by using this procedure. For powered on virtual machines, use the procedures for powered on source machines.

If you connect to a vCenter Server that is part of an environment that contains multiple vCenter Server instances, Converter Standalone displays only ESX hosts managed directly by the currently connected vCenter Server.

**Prerequisites**

If the source machine that you want to convert resides on a VMware DRS cluster that vCenter Server manages, set VMware DRS Power Management (DPM) to manual so that DPM does not power off the ESX hosts used by Converter Standalone. When the conversion process completes, restore DPM to its original settings. For information about how to change DPM settings, see the *Resource Management Guide*.

Power off the source machine before the conversion.

**Procedure**

1. On the Source System page of the Conversion wizard, select the **Powered off** radio button and then select **VMware Infrastructure virtual machine** from the **Select source type** drop-down menu.
2. Provide the IP address or host name and credentials for authentication with the ESX host or the vCenter Server, and click **Next**.

The Source Machine page appears, displaying the host name or IP address and the inventory of the ESX host or the vCenter Server.

**What to do next**

On the Source Machine page of the Conversion wizard, you can browse the virtual infrastructure inventory and select the virtual machine to convert.
Specify the vCenter Server Virtual Machine to Convert

If you choose to convert a virtual machine managed by a vCenter Server or ESX host, you must browse the inventory to locate the source virtual machine.

Prerequisites

On the Source System page of the Conversion wizard, select VMware Infrastructure virtual machine as the conversion source and click Next to proceed to the Source Machine page.

Procedure

1. (Optional) If you are connected to a vCenter Server, select a virtual machine view from the Specify machine with drop-down menu.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hosts and Clusters</td>
<td>The Inventory tree pane provides a view of hosts, clusters, resource pools, and vApps. If you select a host managed by a cluster, you see the full list of virtual machines and templates in the virtual machine list view. If you select a standalone host or a cluster, you see only the virtual machines that are not deployed in the resource pools of that host or cluster.</td>
</tr>
<tr>
<td>VMs and Templates</td>
<td>The Inventory tree pane provides a view of datacenters and virtual machine folders.</td>
</tr>
</tbody>
</table>

2. (Optional) If you are connected to a vCenter Server, select an object from the Inventory tree pane.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hosts and Clusters</td>
<td>Select cluster, ESX host, resource pool, or vApp.</td>
</tr>
<tr>
<td>VMs and Templates</td>
<td>Select datacenter or virtual machine folder.</td>
</tr>
</tbody>
</table>

3. From the virtual machines list, select the virtual machine you want to convert.

   You can search for virtual machines in the virtual machine list by typing one or more letters of their names in the Search for name with text box. You can clear your search by clicking Clear.

   **Note** You cannot select a virtual machine from an ESX host that is powered off, connected to another vCenter Server, or in maintenance mode.

4. (Optional) To refresh the inventory, click Refresh.

5. (Optional) To view more details about a machine, select it and click View source details.

6. Click Next to proceed to the Destination System page.

What to do next

On the Destination System page, you can select the destination type for the new virtual machine.

Select a VMware Hosted Virtual Machine to Convert

You can convert a virtual machine created or used in a VMware hosted product, such as VMware Workstation, VMware Player, and VMware Fusion.

Prerequisites

Verify that your source machine is a supported VMware Desktop products virtual machine. For more information, see “Supported Source Types,” on page 21.
If you plan to use a network path to locate the source, verify that the machine where Converter Standalone server runs has access to that network path.

Power off the source machine before the conversion.

**Procedure**

1. On the Source System page of the Conversion wizard, select the **Powered off** radio button and then select **VMware Workstation or other VMware virtual machine** from the **Select source type** drop-down menu.

2. Locate the virtual machine source.
   - If you are connected to a remote Converter Standalone server, provide a network path to the source virtual machine file (.vmx) in the **Virtual machine file** text box. For example, `\server\virtual_machines\virtual_machine.vmx`.
   - If you are connected to a local Converter Standalone server, provide a network path or a local path to the .vmx file.
     
     By default, only VMware virtual machine *.*vmx files are displayed.

3. If you are connected to a remote Converter Standalone server, type user credentials for accessing the source virtual machine.
   
   You do not have to provide user credentials if you are connected to a local Converter Standalone server. In such cases, Converter Standalone uses the Windows credentials to connect to the source machine.

4. (Optional) To view more information about the selected source, click **View source details**.

5. Click **Next** to proceed to the Destination System page.

**What to do next**

On the Destination System page, you can select the destination type for the new virtual machine.

**Select a Hyper-V Server Virtual Machine to Convert**

You can convert virtual machines that Hyper-V Server manages.

**Prerequisites**

Power off the source Hyper-V virtual machine.

**Procedure**

1. On the Source System page, select the **Powered off** radio button and then select **Hyper-V Server** from the **Select source type** drop-down menu.

2. Provide the IP address or DNS name and administrative credentials to authenticate with the Hyper-V Server and click **Next**.
   
   If Converter Standalone agent is not already installed on the Hyper-V Server, a dialog box appears. In it, you confirm the installation of Converter Standalone agent.

3. (Optional) Select an uninstallation procedure for Converter Standalone agent and click **Yes**.
   
   Converter Standalone agent is installed on the source Hyper-V Server.

**What to do next**

On the Source Machine page, browse the Hyper-V Server inventory to locate the source virtual machine to convert.
Select the Hyper-V Server Virtual Machine to Convert

If you choose to convert a virtual machine managed by a Hyper-V Server, you must browse the inventory to locate the source virtual machine.

Prerequisites

On the Source System page, select **Hyper-V Server** as the source type and navigate to the Source Machine page.

Procedure

1. On the Source Machine page, select the virtual machine you want to convert.
   
   You can search for virtual machines in the inventory by typing one or more letters of their names in the **Search for name with** text box. You can clear your search by clicking **Clear**.

   **NOTE** You can select only powered off virtual machines. To convert a running machine, on the Source System page select **Powered on machine** as the source type. To convert a suspended machine, power it off and convert it as a Hyper-V Server virtual machine, or power it on and convert it as a powered on source.

2. (Optional) To refresh the inventory, click **Refresh**.
3. (Optional) To view more details about the virtual machine to convert, click **View source details**.
4. Click **Next** to proceed to the Destination System page.

The Converter Standalone agent prepares the Hyper-V source machine for conversion.

What to do next

On the Destination System page, you can select the destination type for the new virtual machine.

Select a Destination for the New Virtual Machine

When you set up a conversion job, you must select a destination for the new virtual machine.

When you use a VMware DRS cluster as the destination, you must set VMware DRS Power Management (DPM) to manual. This setting ensures that DPM does not power off the ESX hosts that Converter Standalone uses. When the conversion process completes, restore DPM to its original settings. For information about how to change DPM settings, see the *vSphere Resource Management Guide*.

**NOTE** For conversions of powered on source machines that run Linux, the only supported destination is a vSphere destination.

Select a Managed Destination

You can convert a virtual machine to use with ESX/ESXi or with an ESX/ESXi host that vCenter Server manages.

Procedure

1. On the Destination System page, select **VMware Infrastructure virtual machine** from the **Select destination type** drop-down menu.
2. Provide the IP address or host name and credentials for authentication with the ESX host or the vCenter Server.
3. (Optional) If you want the data traffic to pass through the Converter Standalone server machine, select the **Use proxy mode** check box.
4 Click Next to proceed to the Destination Virtual Machine page.

What to do next

On the Destination Virtual Machine page, you can specify the name of the destination virtual machine and select the folder in which it should reside.

Name the Destination Virtual Machine and Select a Folder

For vSphere destinations, you can select the destination folder and rename the destination virtual machine.

If you connect to an ESX host directly, you can view only the list of virtual machines. Therefore, you cannot select a destination folder.

Prerequisites

On the Destination System page of the Conversion wizard, select VMware Infrastructure virtual machine as the destination type.

Procedure

1 On the Destination Virtual Machine page, select the datacenter to accommodate the destination virtual machine.

   If you use folders in your virtual environment to manage groups of virtual machines, you can select a folder to accommodate the destination virtual machine.

2 In the Name text box, enter a name for the destination virtual machine.

   By default, Converter Standalone assigns the source machine name in this text box.

   **NOTE** Search the list of virtual machines in the datacenter or folder you selected to ensure that the name you assign to the destination virtual machine does not exist. Virtual machines are filtered as you type. You can clear your search by clicking Clear.

3 (Optional) To refresh the inventory, click Refresh.

4 Click Next to proceed to the Destination Location page.

What to do next

On the Destination Location page, you can modify the destination environment for the new virtual machine. This includes selecting a host, resource pool, or cluster to accommodate the destination virtual machine, selecting the Datastore to hold the files of the destination virtual machine, and selecting the virtual hardware version to install on the destination virtual machine.

Customize the Location of the Destination Virtual Machine

For vSphere destinations, you can select an ESX/ESXi host, a resource pool, or a cluster. You can also select a datastore and the virtual hardware version to be installed on the destination.

Prerequisites

On the Destination Virtual Machine page, name the destination virtual machine. If the destination is a vCenter Server, select the destination folder.
Procedure

1. On the Destination Location page of the Conversion wizard, select a datacenter object from the inventory to accommodate the destination virtual machine.
   - Select an ESX/ESXi host.
   - Select a resource pool.
   - Select a cluster.
   
   On the selected cluster, if DRS is not running in the automated mode, you can select an ESX/ESXi host that belongs to the selected cluster from the Host drop-down menu.

2. (Optional) From the Datastore drop-down menu, select the datastore to hold the destination virtual machine files.

3. (Optional) From the Virtual machine version drop-down menu, select the virtual hardware version for the destination virtual machine.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Version 7</td>
<td>Select if the destination host is running ESX/ESXi 4.x or later.</td>
</tr>
<tr>
<td>Version 8</td>
<td>Select if the destination host is running ESXi 5.0 or later.</td>
</tr>
<tr>
<td>Version 9</td>
<td>Select if the destination host is running ESXi 5.1 or later.</td>
</tr>
<tr>
<td>Version 10</td>
<td>Select if the destination host is running ESXi 5.5 or later.</td>
</tr>
<tr>
<td>Version 11</td>
<td>Select if the destination host is running ESXi 6.0 or later.</td>
</tr>
</tbody>
</table>

The Virtual machine version drop-down menu lists only the virtual hardware versions that are compatible with the destination location.

4. Click Next to proceed to the Options page.

What to do next

On the Options page, you can set up the parameters of the conversion task. These settings include data layout, network settings, and guest operating system customization.

Select a Hosted Destination

You can convert a virtual machine for use with VMware Workstation, VMware Fusion, VMware Server, or VMware Player.

Prerequisites

If you plan to use a network path to locate the destination, verify that you have access to that network path.

Procedure

1. On the Destination System page, select VMware Workstation or other VMware virtual machine from the Select destination type drop-down menu.

2. Select the destination VMware hosted product from the Select VMware product drop-down menu.

3. Provide a name for the destination virtual machine in the Name text box.

4. Specify the location to store the destination virtual machine files.
   - If you are connected to a remote Converter Standalone server, provide a network path to the destination directory. For example, `\\server\virtual_machines\`.
   - If you are connected to a local Converter Standalone server, provide a network path or a local path to the destination directory.
5  (Optional) If the destination directory is password-protected, provide valid user credentials.
   You do not have to provide user credentials if the destination location is on the local storage of the
   machine where Converter Standalone server runs.

6  Click **Next** to proceed to the Options page.

**What to do next**

On the Options page, you can set up the parameters of the conversion task. These settings include data
layout, network settings, and guest operating system customization.

**Configure the Hardware of the Destination Virtual Machine**

You can configure the virtual hardware resources that the destination virtual machine uses.

- **Organize the Data to Be Copied on the Destination Machine** on page 52
  
  Your selected source and destination determine the available data cloning options. For a conversion
  job, you can copy all disks to the destination or select the volumes to be copied or to be excluded. For
  destinations with multiple datastores, you can select the data location on specific datastores in your
  virtual environment.

- **Edit the Number of Processor Sockets and Cores** on page 62
  
  You can change the number of virtual sockets and the number of processor cores per socket that the
  destination virtual machine uses.

- **Allocate Memory for the Destination Virtual Machine** on page 62
  
  You can change the amount of memory allocated to the destination virtual machine.

- **Select a Disk Controller for the Destination Virtual Machine** on page 63
  
  You can select the disk controller type for the destination virtual disks.

- **Configure the Network Settings of the Destination Virtual Machine** on page 64
  
  You can change the number of network adapters and select the network that the destination virtual
  machine uses.

- **Configure the Network for the Helper Virtual Machine** on page 64
  
  When you convert a powered on Linux machine, Converter Standalone creates a Helper virtual
  machine on the destination. The Helper virtual machine needs network access to the source machine
to clone the source files. Default conversion settings enforce automatic acquisition of an IPv4 address,
IPv6 address, and a DNS server for the Helper virtual machine, but you can set up this network
connection manually.

**Organize the Data to Be Copied on the Destination Machine**

Your selected source and destination determine the available data cloning options. For a conversion job, you
can copy all disks to the destination or select the volumes to be copied or to be excluded. For destinations
with multiple datastores, you can select the data location on specific datastores in your virtual environment.

If you selected a source with multiple disks and volumes, you can set Converter to start concurrent data
transfers. For details, see “Set the Number of Data Connections per Task,” on page 92.

**Prerequisites**

On the Options page of the Conversion wizard, click **Data to copy** in the options list.
Procedure

◆ In the Data to copy pane, select a copy mode from the Data copy type drop-down menu.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copy all disks and maintain layout</td>
<td>Results in disk-based cloning. You can preserve the source disk layout in the destination virtual machine. This option is not available for powered on source machines.</td>
</tr>
<tr>
<td>Select volumes to copy</td>
<td>Results in volume-based cloning. Volume-based cloning is performed at file or block level. You can select the volumes to be copied to the destination virtual machine. You can also resize and reorganize the volume layout. This option is available for powered on source machines that run Windows and Linux, and for all other supported sources that run Windows.</td>
</tr>
<tr>
<td>Linked clone</td>
<td>Results in creating a VMware virtual machine that shares the virtual disk of the source machine or system image. This option is available only for hosted sources and hosted destinations.</td>
</tr>
</tbody>
</table>

What to do next

The destination that you select determines the destination disk types that are available to you. To support destination virtual disks on FAT file systems, divide the source data into 2GB files. For detailed information about destination virtual disks types, see “Supported Destination Disk Types,” on page 24.

Resize a Volume

To manage disk space on the destination datastore, you can resize the disk volumes before you begin the conversion.

Prerequisites

On the Options page of the Conversion wizard, click Data to copy in the options list.

Procedure

1. From the Data copy type drop-down menu, select Select volumes to copy.
2. In the Destination size column, select an option to specify the size of a destination volume.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maintain size</td>
<td>Maintains the original source volume size. Note If the volume is nearly full, Converter Standalone allocates a buffer amount and displays a volume amount greater than the source volume.</td>
</tr>
<tr>
<td>Min size</td>
<td>Copies only the used space of the source volume. Note Converter Standalone allocates a buffer amount and displays a volume amount greater than the source volume.</td>
</tr>
<tr>
<td>Type size in GB</td>
<td>Allows you to type a custom size in GB for the destination volume. The value cannot be smaller than the used space on the source volume, but can be larger than the total size of the source volume. The maximum allowed volume size for the destination is 999999GB.</td>
</tr>
<tr>
<td>Type size in MB</td>
<td>Allows you to type a custom size in MB for the destination volume. The value cannot be smaller than the used space on the source volume, but can be larger than the total size of the source volume. The maximum allowed volume size for the destination is 999999GB.</td>
</tr>
</tbody>
</table>
3 Save your settings.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select another option from the options list</td>
<td>Saves your settings and displays the pane for the selected option.</td>
</tr>
<tr>
<td>Click Next</td>
<td>Saves your settings and displays the next page of the Conversion wizard.</td>
</tr>
<tr>
<td></td>
<td>■ The Customizations page is displayed if you select Customize guest</td>
</tr>
<tr>
<td></td>
<td>preferences for the virtual machine in the Advanced options pane.</td>
</tr>
<tr>
<td></td>
<td>■ The Summary page is displayed if you do not select Customize guest</td>
</tr>
<tr>
<td></td>
<td>preferences for the virtual machine in the Advanced options pane.</td>
</tr>
</tbody>
</table>

### Change a Volume Cluster Size

To enhance performance and storage space, you can change the volume cluster size before the conversion. Modifying the cluster size changes the cloning mode from block level to file level.

**Prerequisites**

- On the Options page of the Conversion wizard, click Data to copy in the options list.
- Ensure that the source is a Windows machine.

**Procedure**

1. From the Data copy type drop-down menu, select Select volumes to copy.
2. Click Advanced and select the Destination layout tab.
3. Select the volume for which you want to change the cluster size.
4. In the Cluster size column, select an option to specify the cluster size of the destination volume.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default cluster size</td>
<td>Applies a default cluster size to the destination volume.</td>
</tr>
<tr>
<td>Keep source cluster size</td>
<td>Preserves the cluster size of the original source volume.</td>
</tr>
<tr>
<td>Select a predefined size</td>
<td>Allows you to select a cluster size for the destination volume from a list of supported values.</td>
</tr>
</tbody>
</table>

In the Copy type column, you can verify that the cloning operation type is set to file level.

5 Save your settings.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select another option from the options list</td>
<td>Saves your settings and displays the pane for the selected option.</td>
</tr>
<tr>
<td>Click Next</td>
<td>Saves your settings and displays the next page of the Conversion wizard.</td>
</tr>
<tr>
<td></td>
<td>■ The Customizations page is displayed if you select Customize guest</td>
</tr>
<tr>
<td></td>
<td>preferences for the virtual machine in the Advanced options pane.</td>
</tr>
<tr>
<td></td>
<td>■ The Summary page is displayed if you do not select Customize guest</td>
</tr>
<tr>
<td></td>
<td>preferences for the virtual machine in the Advanced options pane.</td>
</tr>
</tbody>
</table>

### Exclude a Source Volume from the Conversion Process

You can choose not to copy a volume from the source machine to the destination virtual machine. During the conversion process, Converter Standalone ignores the deselected volumes and copies only the volumes that are selected.

The source virtual machine must have more than one volume to be able to deselect existing volumes.
Prerequisites

On the Options page of the Conversion wizard, click **Data to copy** in the options list.

Procedure

1. From the **Data copy type** drop-down menu, select **Select volumes to copy**.
2. Deselect the volumes that you do not want to copy to the destination virtual machine.
3. Save your settings.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select another option from the options list</td>
<td>Saves your settings and displays the pane for the selected option.</td>
</tr>
<tr>
<td>Click Next</td>
<td>Saves your settings and displays the next page of the Conversion wizard.</td>
</tr>
<tr>
<td></td>
<td>■ The Customizations page is displayed if you select Customize guest preferences for the virtual machine in the Advanced options pane.</td>
</tr>
<tr>
<td></td>
<td>■ The Summary page is displayed if you do not select Customize guest preferences for the virtual machine in the Advanced options pane.</td>
</tr>
</tbody>
</table>

The deselected volumes are ignored during the conversion process and do not appear on the destination virtual machine.

**Move a Volume to a Different Virtual Disk**

You can add virtual disks to the destination virtual machine and move source volumes in the new disks.

The number of virtual disks you can create depends on the number of volumes that exist on the source virtual machine. For example, if you have only one volume on the source virtual machine, you cannot add a virtual disk to the destination virtual machine.

You cannot move the system volume where the guest operating system is installed. For example, if your Windows operating system is installed on C:, you cannot move the C: volume.

Prerequisites

On the Options page of the Conversion wizard, click **Data to copy** in the options list.

Procedure

1. From the **Data copy type** drop-down menu, select **Select volumes to copy**.
2. Click **Advanced** and select the **Destination layout** tab.
3. Select a volume from the list and click **Add disk**.
   A new virtual disk appears in the Destination layout column.
4. Select a source volume and use the **Move up** or **Move down** buttons to accommodate the volume in the new virtual disk.
   The partitioning scheme of the first source volume that you move will determine the type of the new virtual disk on the destination virtual machine.
   If you leave the virtual disk empty, Converter Standalone does not create the virtual disk on the destination virtual machine.

The selected source volume is copied to a new virtual disk on the destination virtual machine.
Select the Destination Datastore for a Source Volume

You can store a disk volume in a datastore different from the one that accommodates the virtual machine configuration file (.vmx).

You can select the destination datastore for a volume only for managed destinations with more than one datastore.

Prerequisites

On the Options page of the Conversion wizard, click Data to copy in the options list.

Procedure

1. From the Data copy type drop-down menu, select Select volumes to copy.
2. Click Advanced and select the Destination layout tab.
3. Select a volume from the list and click Add disk.
   
   A new virtual disk appears in the Destination layout column.
4. Select a source volume and use the Move up or Move down buttons to accommodate the volume in the new virtual disk.
   
   The partitioning scheme of the first source volume that you move will determine the type of the new virtual disk on the destination virtual machine.
   
   If you leave the virtual disk empty, Converter Standalone does not create the virtual disk on the destination virtual machine.
5. Highlight the new virtual disk and select a different datastore from the Destination datastore drop-down menu.
6. Save your settings.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select another option from the options list</td>
<td>Saves your settings and displays the pane for the selected option.</td>
</tr>
<tr>
<td>Click Next</td>
<td>Saves your settings and displays the next page of the Conversion wizard.</td>
</tr>
<tr>
<td></td>
<td>■ The Customizations page is displayed if you select Customize guest preferences for the virtual machine in the Advanced options pane.</td>
</tr>
<tr>
<td></td>
<td>■ The Summary page is displayed if you do not select Customize guest preferences for the virtual machine in the Advanced options pane.</td>
</tr>
</tbody>
</table>

The virtual disk file (.vmdk) that contains the volume is stored in the selected datastore.

Add a Virtual Disk

You can add additional virtual disks to the destination virtual machine.

The number of virtual disks on the destination virtual machine depends on the number of volumes that exist on the source virtual machine. For example, if you have only one volume on the source virtual machine, you cannot add a virtual disk to the destination virtual machine.

Prerequisites

You must have more than one volumes on the source machine to be able to add an additional virtual disk.

On the Options page of the Conversion wizard, click Data to copy in the options list.
Procedure
1 From the Data copy type drop-down menu, select Select volumes to copy.
2 Click Advanced and select the Destination layout tab.
3 Click Add disk.
   A new virtual disk appears in the Destination layout column.
4 Click on the new virtual disk to select it.
5 Save your settings.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select another option from the options list</td>
<td>Saves your settings and displays the pane for the selected option.</td>
</tr>
</tbody>
</table>
| Click Next                    | Saves your settings and displays the next page of the Conversion wizard.  
   - The Customizations page is displayed if you select Customize guest preferences for the virtual machine in the Advanced options pane.  
   - The Summary page is displayed if you do not select Customize guest preferences for the virtual machine in the Advanced options pane. |

The new virtual disk is created on the destination datastore.

Set Up a Virtual Disk as a Logical-Volume Group Container
To preserve the LVM structure when converting a Linux source, you can set up a virtual disk as a logical-volume container. Converter Standalone allows you to preserve and modify the source LVM structure.
You can manage logical volumes and logical-volume groups in the same way as basic volumes and disks.
Logical-volume groups are listed together with virtual disks and are marked with a different icon.
You cannot move active and system volumes in a logical-volume group.

Prerequisites
Ensure that the source is a Linux machine and supports LVM.
Only LVM2 is supported.

Procedure
1 From the Data copy type drop-down menu, select Select volumes to copy.
2 Click Advanced and select the Destination layout tab.
3 Select a disk and click To LVG.

Move a Disk to a Different Datastore
You can use disk-based cloning to select a different datastore for a destination virtual disk.

Prerequisites
On the Options page of the Conversion wizard, click Data to copy in the options list.
You can change the destination datastore for a disk only for managed destinations with more than one datastore.

Procedure
1 From the Data copy type drop-down menu, select Copy all disks and maintain layout.
2 Click the name of the virtual disk to relocate and select a different datastore from the Destination datastore drop-down menu.

3 Save your settings.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select another option from the options list</td>
<td>Saves your settings and displays the pane for the selected option.</td>
</tr>
<tr>
<td>Click Next</td>
<td>Saves your settings and displays the next page of the Conversion wizard.</td>
</tr>
</tbody>
</table>

- The Customizations page is displayed if you select Customize guest preferences for the virtual machine in the Advanced options pane.
- The Summary page is displayed if you do not select Customize guest preferences for the virtual machine in the Advanced options pane.

The virtual disk file (.vmdk) is stored in the selected datastore.

**Create an Expandable Disk on a Managed Destination**

To save space on the destination datastore, you can copy only the existing data from a source virtual disk and create an expandable disk on the destination. Later, as you use the destination virtual machine and write new data, the destination virtual disk grows.

You can create expandable disks on managed destinations that support thin provisioning through their GUI.

You can create an expandable disk by using volume-based or disk-based cloning.

**Prerequisites**

On the Options page of the Conversion wizard, click Data to copy in the options list.

**Procedure**

- Use disk-based cloning to create an expandable disk.
  a From the Data copy type drop-down menu, select Copy all disks and maintain layout.
  b Click a virtual disk and select Thin from the Type drop-down menu.
  c To apply your settings, select another option from the options list or click Next.
- Use volume-based cloning to create an expandable disk.
  a From the Data copy type drop-down menu, select Select volumes to copy and click Advanced.
  b Select the Destination layout tab, click a virtual disk, and select Thin from the Type drop-down menu.
  c To apply your settings, select another option from the options list or click Next.

Converter Standalone copies only the existing data to the destination datastore. The empty disk space from the virtual disk is not copied to the datastore. As you use the destination virtual machine and write new data to the disk, the size of the destination disk grows.

**Create an Expandable Disk on a Hosted Destination**

To save space on the destination, you can copy only the existing data from a source virtual disk. Later, as you use the destination virtual machine and write new data, the destination virtual disk grows.

You can create an expandable disk by using volume-based or disk-based cloning.
Prerequisites
You must select a hosted destination, such as VMware Workstation, to use the Not pre-allocated disk option.

On the Options page of the Conversion wizard, click Data to copy in the options list.

Procedure
- Use disk-based cloning to create an expandable disk.
  a From the Data copy type drop-down menu, select Copy all disks and maintain layout.
  b From the Type drop-down menu, select Not pre-allocated.
  c To apply your settings, select another option from the options list or click Next.
- Use volume-based cloning to create an expandable disk.
  a From the Data copy type drop-down menu, select Select volumes to copy and click Advanced.
  b Select the Destination layout tab, select a virtual disk, and select Not pre-allocated from the Type drop-down menu.
  c To apply your settings, select another option from the options list or click Next.

Converter Standalone copies only the existing data to the destination datastore. The empty disk space from the virtual disk is not copied to the datastore. As you use the destination virtual machine and write new data to the disk, the size of the destination disk grows.

Exclude a Source Disk from the Conversion Process
You can select a disk from the source machine and delete it from the disk layout of the destination virtual machine.

Prerequisites
The source machine must have more than one hard disk.

On the Options page of the Conversion wizard, click Data to copy in the options list.

Procedure
1 From the Data copy type drop-down menu, select Select volumes to copy.
2 Delete the disk.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Preserve the volumes associated with</td>
<td>a Click Advanced and select the Destination layout tab.</td>
</tr>
<tr>
<td>the disk</td>
<td>b Move the volumes from the disk that you want to delete to another virtual</td>
</tr>
<tr>
<td></td>
<td>c Highlight the empty disk and click Remove disk.</td>
</tr>
<tr>
<td>Delete the volumes associated with</td>
<td>a Click Advanced and select the Source volumes tab.</td>
</tr>
<tr>
<td>the disk</td>
<td>b Deselect the volumes associated with the disk that you want to delete.</td>
</tr>
</tbody>
</table>
Copy All Disks to the Destination

To preserve the source disks on the destination virtual machine, you can copy all disks to the destination. Disk-based cloning is not available for powered on source machines.

Prerequisites

On the Options page of the Conversion wizard, click Data to copy in the options list.

Procedure

1. From the Data copy type drop-down menu, select Copy all disks and maintain layout.
2. (Optional) If the destination datastore is low on disk space, click a virtual disk and select a different datastore from the Destination datastore drop-down menu.

   **NOTE** You must have access to more than one datastore to move a disk to a different datastore.

3. Save your settings.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select another option from the options list</td>
<td>Saves your settings and displays the pane for the selected option.</td>
</tr>
<tr>
<td>Click Next</td>
<td>Saves your settings and displays the next page of the Conversion wizard.</td>
</tr>
</tbody>
</table>

Converter Standalone copies the disks to the selected datastores and preserves the source disk layout.

Create an Optimized Partition Layout

By default, Converter Standalone optimizes the disk partitions alignment. Optimizing the partition alignment improves the performance of the destination virtual machine.

Prerequisites

On the Options page of the Conversion wizard, click Data to copy in the options list.

Procedure

1. From the Data copy type drop-down menu, select Select volumes to copy.
2. Select the Create optimized partition layout check box.
3 Save your settings.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select another option from the options list</td>
<td>Saves your settings and displays the pane for the selected option.</td>
</tr>
<tr>
<td>Click Next</td>
<td>Saves your settings and displays the next page of the Conversion wizard.</td>
</tr>
<tr>
<td></td>
<td>- The Customizations page is displayed if you select Customize guest preferences for the virtual machine in the Advanced options pane.</td>
</tr>
<tr>
<td></td>
<td>- The Summary page is displayed if you do not select Customize guest preferences for the virtual machine in the Advanced options pane.</td>
</tr>
</tbody>
</table>

Creating an optimized partition layout aligns the partitions on a 1MB boundary for Windows sources and on a 64KB boundary for Linux sources.

**Create a Linked Clone**

A linked clone is a VMware virtual machine that shares the virtual disk of the source virtual machine or system image.

You can create linked clones only when you convert a virtual machine or other image source to a hosted destination.

You cannot create a linked clone if the source image is password-protected.

**Prerequisites**

Turn off the source virtual machine.

To verify that your source type is a supported source, see “Supported Source Types,” on page 21.

**Procedure**

1. On the Destination System page, select VMware Workstation or other VMware virtual machine as a destination and click Next.
2. On the Options page, click Data to copy in the left pane.
3. In the Data copy type drop-down menu, select Linked clone.
4. Save your settings.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select another option from the options list</td>
<td>Saves your settings and displays the pane for the selected option.</td>
</tr>
<tr>
<td>Click Next</td>
<td>Saves your settings and displays the next page of the Conversion wizard.</td>
</tr>
<tr>
<td></td>
<td>- The Customizations page is displayed if you select Customize guest preferences for the virtual machine in the Advanced options pane.</td>
</tr>
<tr>
<td></td>
<td>- The Summary page is displayed if you do not select Customize guest preferences for the virtual machine in the Advanced options pane.</td>
</tr>
</tbody>
</table>

You have set up a conversion job to create a linked clone.
Edit the Number of Processor Sockets and Cores

You can change the number of virtual sockets and the number of processor cores per socket that the destination virtual machine uses.

**Prerequisites**

Make sure the destination host and the guest operating system support the number of processor cores you assign to the destination virtual machine.

*NOTE* You can change the number of cores per socket on virtual hardware version 8 and later.

On the Options page of the Conversion wizard, click **Devices** in the options list.

**Procedure**

1. Click the **Other** tab.
2. From the **Number of virtual sockets** drop-down menu on the CPU Settings panel, select the number of virtual sockets for the destination virtual machine.
3. From the **Number of cores per socket** drop-down menu on the CPU Settings panel, select the number of cores per socket for the destination virtual machine.
4. Save your settings.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select another option from the options list</td>
<td>Saves your settings and displays the pane for the selected option.</td>
</tr>
<tr>
<td>Click Next</td>
<td>Saves your settings and displays the next page of the Conversion wizard.</td>
</tr>
<tr>
<td></td>
<td>■ The Customizations page is displayed if you select Customize guest preferences for the virtual machine in the Advanced options pane.</td>
</tr>
<tr>
<td></td>
<td>■ The Summary page is displayed if you do not select Customize guest preferences for the virtual machine in the Advanced options pane.</td>
</tr>
</tbody>
</table>

The destination virtual machine is configured with the number of virtual processor sockets and cores that you selected. If Converter Standalone shows a message that the destination hardware does not support the number of cores you selected, you must select a supported number of sockets and cores.

Allocate Memory for the Destination Virtual Machine

You can change the amount of memory allocated to the destination virtual machine.

By default, Converter Standalone recognizes the amount of memory on the source machine and allocates it to the destination virtual machine.

**Prerequisites**

On the Options page of the Conversion wizard, click **Devices** in the options list.

**Procedure**

1. Click the **Memory** tab.
2. In the Memory panel, use the slider or the spin-box to specify the amount of memory for the destination virtual machine.
3  Save your settings.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select another option from the options list</td>
<td>Saves your settings and displays the pane for the selected option.</td>
</tr>
<tr>
<td>Click Next</td>
<td>Saves your settings and displays the next page of the Conversion wizard.</td>
</tr>
<tr>
<td></td>
<td>- The Customizations page is displayed if you select <strong>Customize guest</strong></td>
</tr>
<tr>
<td></td>
<td>preferences for the virtual machine in the Advanced options pane.</td>
</tr>
<tr>
<td></td>
<td>- The Summary page is displayed if you do not select <strong>Customize guest</strong></td>
</tr>
<tr>
<td></td>
<td>preferences for the virtual machine in the Advanced options pane.</td>
</tr>
</tbody>
</table>

Converter Standalone validates the amount of memory. A warning appears if you set the memory amount to more than the maximum supported or to less than the required minimum.

**Select a Disk Controller for the Destination Virtual Machine**

You can select the disk controller type for the destination virtual disks.

**Prerequisites**

On the Options page of the Conversion wizard, click **Devices** in the options list.

**Procedure**

1  Click the **Other** tab.

2  From the **Disk controller** drop-down menu, select a disk controller for the destination virtual disk or retain the selected recommended type.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SCSI Bus Logic</td>
<td>Use SCSI virtual disks in the destination virtual machine.</td>
</tr>
<tr>
<td>IDE</td>
<td>Use IDE virtual disks in the destination virtual machine.</td>
</tr>
<tr>
<td>SCSI LSI Logic</td>
<td>Use LSI Logic SCSI virtual disks in the destination virtual machine.</td>
</tr>
<tr>
<td>SCSI LSI Logic SAS</td>
<td>Use LSI Logic SCSI (SAS) virtual disks in the destination virtual machine.</td>
</tr>
<tr>
<td>SATA</td>
<td>Use SATA virtual disks in the destination virtual machine.</td>
</tr>
<tr>
<td>Preserve source</td>
<td>Use the same types of disk controllers as those installed on the source</td>
</tr>
<tr>
<td></td>
<td>machine. If they are not supported on the destination virtual machine,</td>
</tr>
<tr>
<td></td>
<td>replace them with supported ones. This option is not available for</td>
</tr>
<tr>
<td></td>
<td>powered on Linux sources.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong> When converting Linux virtual machines on ESX and vCenter Server</td>
</tr>
<tr>
<td></td>
<td>earlier than 4.1, the system might not retrieve the full list of</td>
</tr>
<tr>
<td></td>
<td>supported controllers.</td>
</tr>
</tbody>
</table>

3  Save your settings.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select another option from the options list</td>
<td>Saves your settings and displays the pane for the selected option.</td>
</tr>
<tr>
<td>Click Next</td>
<td>Saves your settings and displays the next page of the Conversion wizard.</td>
</tr>
<tr>
<td></td>
<td>- The Customizations page is displayed if you select <strong>Customize guest</strong></td>
</tr>
<tr>
<td></td>
<td>preferences for the virtual machine in the Advanced options pane.</td>
</tr>
<tr>
<td></td>
<td>- The Summary page is displayed if you do not select <strong>Customize guest</strong></td>
</tr>
<tr>
<td></td>
<td>preferences for the virtual machine in the Advanced options pane.</td>
</tr>
</tbody>
</table>
Configure the Network Settings of the Destination Virtual Machine

You can change the number of network adapters and select the network that the destination virtual machine uses.

For managed destinations, you can also select the controller type for each network adapter.

**Procedure**

1. On the Options page of the Conversion wizard, select **Networks** from the options list.

2. From the **Network adapters to connect** drop-down menu, select the number of network adapters to be used by the destination virtual machine.

3. Configure each of the network adapters for the destination.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>For managed destinations a</td>
<td>From the <strong>Network</strong> drop-down menu, select the network that the adapter connects to.</td>
</tr>
<tr>
<td>b</td>
<td>From the <strong>Controller type</strong> drop-down menu, select the controller type.</td>
</tr>
<tr>
<td>For hosted destinations</td>
<td>From the <strong>Connection type</strong> drop-down menu, select the connection type.</td>
</tr>
</tbody>
</table>

4. To connect an adapter when you power on the destination virtual machine, select the **Connect at power-on** check box.

5. Save your settings.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select another option from the options list</td>
<td>Saves your settings and displays the pane for the selected option.</td>
</tr>
<tr>
<td>Click Next</td>
<td>Saves your settings and displays the next page of the Conversion wizard.</td>
</tr>
<tr>
<td></td>
<td>The Customizations page is displayed if you select <strong>Customize guest preferences for the virtual machine</strong> in the Advanced options pane.</td>
</tr>
<tr>
<td></td>
<td>The Summary page is displayed if you do not select <strong>Customize guest preferences for the virtual machine</strong> in the Advanced options pane.</td>
</tr>
</tbody>
</table>

Configure the Network for the Helper Virtual Machine

When you convert a powered on Linux machine, Converter Standalone creates a Helper virtual machine on the destination. The Helper virtual machine needs network access to the source machine to clone the source files. Default conversion settings enforce automatic acquisition of an IPv4 address, IPv6 address, and a DNS server for the Helper virtual machine, but you can set up this network connection manually.

**Procedure**

1. On the Options page of the Conversion wizard, click **Helper VM network**.

2. (Optional) To assign a static IPv4 address to the Helper virtual machine, on tab **IPv4** select **Use the following IP address** and specify the IPv4 address, subnet mask, and default gateway.

   Make sure that the IP address you specify for the Helper virtual machine is not already in use on the network.

3. (Optional) If you want the Helper virtual machine to use only IPv4 address, on tab **IPv6** deselect the **Use IPv6** check box.
4. (Optional) To assign a static IPv6 address to the Helper virtual machine, on tab IPv6 select **Use the following IPv6 address** and specify the IPv6 address, subnet prefix length, and default gateway. Make sure that the IP address you specify for the Helper virtual machine is not already in use on the network.

5. (Optional) If you want the Helper virtual machine to use only IPv6 address, on tab IPv4 deselect the **Use IPv4** check box.

6. (Optional) Select **Use the following DNS server address** and type the preferred DNS server address to configure the DNS server address manually. Optionally, you can type an alternative DNS server address as well.

7. Save your settings.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select another option from the options list</td>
<td>Saves your settings and displays the pane for the selected option.</td>
</tr>
<tr>
<td>Click Next</td>
<td>Saves your settings and displays the next page of the Conversion wizard.</td>
</tr>
<tr>
<td></td>
<td>- The Customizations page is displayed if you select <strong>Customize guest preferences for the virtual machine</strong> in the Advanced options pane.</td>
</tr>
<tr>
<td></td>
<td>- The Summary page is displayed if you do not select <strong>Customize guest preferences for the virtual machine</strong> in the Advanced options pane.</td>
</tr>
</tbody>
</table>

Converter Standalone uses the IP address and DNS server you specify to copy data from the source Linux machine to the Helper virtual machine during conversion.

**Configure the Software on the Destination Virtual Machine**

You can configure the guest operating system so that it is ready to operate in a virtual environment.

Software configuration includes a number of settings.

- **Customize the Windows Guest Operating System** on page 65
  You can customize guest operating systems running Windows so that the virtual machine is prepared to work immediately in the destination environment.

- **Install VMware Tools on the Destination Virtual Machine** on page 69
  When converting Windows source machines, you can install VMware Tools to improve graphics performance of the guest operating system. Other enhancements include automatic grab and release of the mouse pointer, copy and paste operations between guest and host, and improved mouse performance.

- **Remove System Restore Checkpoints** on page 69
  When you convert source machines running Windows, you can remove System Restore checkpoints so that the conversion process is faster.

**Customize the Windows Guest Operating System**

You can customize guest operating systems running Windows so that the virtual machine is prepared to work immediately in the destination environment.

**Prerequisites**

- On the Options page of the Conversion wizard, click **Advanced options**, click the **Post-conversion** tab, and select **Customize guest preferences for the virtual machine**. Click **Next** to view and adjust the available customization options.
Customize the Identity of the Destination Virtual Machine on page 66
To configure the identity of the destination virtual machine for the destination network, personalize it by editing its name, owner, and organization name, and by generating a new security ID.

Enter the Windows License Information on page 67
Ensure that you provide licensing information for all destination virtual machines running guest operating systems as necessary. Because of third-party licensing policies, you might not be able to transfer the license from the source machine and you might need to provide a new valid license for the destination virtual machine.

Set the Time Zone for the Destination Virtual Machine on page 67
You can set the time zone if you are converting a virtual machine to use in a different time zone.

Configure the Network Adapters on page 68
You can configure the network settings of the virtual machine to work with the network configuration of the destination environment.

Assign a Workgroup or Domain Details on page 68
You can set up the workgroup and the domain in which the destination virtual machine belongs.

Customize the Identity of the Destination Virtual Machine
To configure the identity of the destination virtual machine for the destination network, personalize it by editing its name, owner, and organization name, and by generating a new security ID.

Prerequisites
On the Options page of the Conversion wizard, click Advanced options, click the Post-conversion tab, and select Customize guest preferences for the virtual machine. Click Next to view and adjust the available customization options.

Procedure
1 On the Customizations page, select Computer information from the options list.
2 Customize the guest operating system identity.
   a In the Computer Name text box, type a computer name to identify the virtual machine on the network.
      Valid characters include A-Z, a-z, 0-9, and the hyphen (-). The underscore (_) is nonstandard, but Converter Standalone permits it. The recommended length for most languages is 15 characters or less. Computer names cannot consist only of numerals.
   b In the Owner Name text box, type the name of the owner of the virtual machine.
      Valid characters include A-Z, a-z, 0-9, and the hyphen (-). The underscore (_) is nonstandard, but Converter Standalone permits it. The owner name cannot have more than 63 characters or consist only of numerals.
   c In the Organization text box, type an organization name.
      Valid characters include all printable characters (A-Z, a-z, 0-9, symbols, and space). The limit is 63 characters.
3 (Optional) To create a new security identifier, select Generate New Security ID (SID).
   By default, the Generate New Security ID (SID) check box is selected for source systems that run Windows Vista or later and cannot be deselected.

The identifiers of the destination virtual machine are assigned according to your settings.
What to do next
You can select another option to set or click Next to view a summary of the conversion job. If the Next button is inactive, check the Current settings list for other settings that need your attention on this page.

Enter the Windows License Information
Ensure that you provide licensing information for all destination virtual machines running guest operating systems as necessary. Because of third-party licensing policies, you might not be able to transfer the license from the source machine and you might need to provide a new valid license for the destination virtual machine.

Prerequisites
On the Options page of the Conversion wizard, click Advanced options, click the Post-conversion tab, and select Customize guest preferences for the virtual machine. Click Next to view and adjust the available customization options.

Procedure
1. On the Customizations page, select Windows license from the options list.
2. In the Product ID text box, type the licensing information for the destination virtual machine.
3. (Optional) If the guest operating system is Windows Server 2008, select Include server license information.
4. Select a Server license mode option.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Per seat</td>
<td>For individual user licenses.</td>
</tr>
<tr>
<td>Per server</td>
<td>For a concurrent user license. When you select this option, you need to type a value in the Maximum connections text box.</td>
</tr>
</tbody>
</table>

The Windows license information is saved to the destination virtual machine after the conversion.

What to do next
You can select another option to set or click Next to view a summary of the conversion job. If the Next button is inactive, check the Current settings list for other settings that need your attention on this page.

Set the Time Zone for the Destination Virtual Machine
You can set the time zone if you are converting a virtual machine to use in a different time zone.

Prerequisites
On the Options page of the Conversion wizard, click Advanced options, click the Post-conversion tab, and select Customize guest preferences for the virtual machine. Click Next to view and adjust the available customization options.

Procedure
1. On the Customizations page, select Time zone from the options list.
2. Select the target time zone from the Time zone drop-down menu.

The time zone is set on the destination virtual machine after the conversion.
**What to do next**

You can select another option to set or click **Next** to view a summary of the conversion job. If the **Next** button is inactive, check the Current settings list for other settings that need your attention on this page.

**Configure the Network Adapters**

You can configure the network settings of the virtual machine to work with the network configuration of the destination environment.

The option for configuring network adapters is available for all supported destinations.

**Prerequisites**

On the Options page of the Conversion wizard, click **Advanced options**, click the **Post-conversion** tab, and select **Customize guest preferences for the virtual machine**. Click **Next** to view and adjust the available customization options.

**Procedure**

1. On the Customizations page, select **Network interface settings** from the options list.
2. Select a network adapter and click **Customize** to configure its properties.
   
   a. On the **IPv4** tab, type the IPv4 address and DNS server address.
   
   b. On the **IPv6** tab, type the IPv6 address and DNS server address.
   
   c. On the **DNS** tab, configure the DNS connections by adding DNS suffixes.
   
   d. Type a DNS suffix and click **Add**.
      
      You can add more than one DNS suffix.
   
   e. If you have provided multiple DNS suffixes, use **Move up** and **Move down** to set the order in which the guest operating system uses the connections.
   
   f. On the **WINS** tab, type the primary and secondary WINS IPv4 address in the text box.

When powered on, the destination virtual machine uses the network settings that you configured.

**What to do next**

You can select another option to set or click **Next** to view a summary of the conversion job. If the **Next** button is inactive, check the Current settings list for other settings that need your attention on this page.

**Assign a Workgroup or Domain Details**

You can set up the workgroup and the domain in which the destination virtual machine belongs.

**Prerequisites**

On the Options page of the Conversion wizard, click **Advanced options**, click the **Post-conversion** tab, and select **Customize guest preferences for the virtual machine**. Click **Next** to view and adjust the available customization options.

**Procedure**

1. On the Customizations page, select **Workgroup/Domain** from the options list.
Select how the virtual machine participates in the destination network.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Workgroup</td>
<td>The text box must have a value. Valid characters include A-Z, a-z, 0-9, space, and the hyphen (-). The maximum length is 15 characters.</td>
</tr>
<tr>
<td>Windows server domain</td>
<td>The text box must have a value. Valid characters include A-Z, a-z, 0-9, space, period, and the hyphen (-). The maximum length is 64 characters. User credentials are required.</td>
</tr>
</tbody>
</table>

The destination virtual machine connects to the specified workgroup and domain server.

**What to do next**

You can select another option to set or click Next to view a summary of the conversion job. If the Next button is inactive, check the Current settings list for other settings that need your attention on this page.

**Install VMware Tools on the Destination Virtual Machine**

When converting Windows source machines, you can install VMware Tools to improve graphics performance of the guest operating system. Other enhancements include automatic grab and release of the mouse pointer, copy and paste operations between guest and host, and improved mouse performance.

**Prerequisites**

On the Options page of the Conversion wizard, click **Advanced options** in the options list.

**Procedure**

1. Click the Post-conversion tab.
2. In the Post-conversion processing section, select the **Install VMware Tools on the destination virtual machine** check box.
3. Save your settings.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select another option from the options list</td>
<td>Saves your settings and displays the pane for the selected option.</td>
</tr>
<tr>
<td>Click Next</td>
<td>Saves your settings and displays the next page of the Conversion wizard.</td>
</tr>
<tr>
<td></td>
<td>- The Customizations page is displayed if you select <strong>Customize guest preferences for the virtual machine</strong> in the Advanced options pane.</td>
</tr>
<tr>
<td></td>
<td>- The Summary page is displayed if you do not select <strong>Customize guest preferences for the virtual machine</strong> in the Advanced options pane.</td>
</tr>
</tbody>
</table>

Converter Standalone installs VMware Tools on the destination machine when the destination machine is powered on for the first time after the conversion job.

**Remove System Restore Checkpoints**

When you convert source machines running Windows, you can remove System Restore checkpoints so that the conversion process is faster.

System Restore is enabled on Windows systems by default. If you are performing volume-based file-level cloning, System Restore checkpoints are removed automatically from the destination virtual machine, regardless of whether the **Remove System Restore checkpoints on destination** check box is selected or deselected. If you are performing disk-based cloning or volume-based block-level cloning, deselecting the check box instructs Converter Standalone to keep the System Restore checkpoints in the destination virtual machine.
Removing System Restore checkpoints prevents the target machine from reverting to a preconversion state. In the target virtual machine, restoring a checkpoint that was created before you cloned the source machine can damage the system and prevent the destination virtual machine from starting up.

**Prerequisites**

On the Options page of the Conversion wizard, click **Advanced options** in the options list.

**Procedure**

1. Click the **Post-conversion** tab.
2. In the Post-conversion processing section, select the **Remove System Restore checkpoints on destination** check box.
3. Save your settings.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select another option from the options list</td>
<td>Saves your settings and displays the pane for the selected option.</td>
</tr>
<tr>
<td>Click Next</td>
<td>Saves your settings and displays the next page of the Conversion wizard.</td>
</tr>
<tr>
<td></td>
<td>- The Customizations page is displayed if you select <strong>Customize guest preferences for the virtual machine</strong> in the Advanced options pane.</td>
</tr>
<tr>
<td></td>
<td>- The Summary page is displayed if you do not select <strong>Customize guest preferences for the virtual machine</strong> in the Advanced options pane.</td>
</tr>
</tbody>
</table>

**Configure the Conversion Job**

You can configure the conversion process and select the behavior of the source and destination machine during and after conversion. You can change the status of the source and destination services only when the source machine is running a Windows operating system.

- **Set the Startup Mode for Destination Services** on page 71
  
  To minimize downtime for a Windows service, you can select the service and set the service startup mode to automatic, manual, or disabled.

- **Stop Services Running on the Source Machine** on page 72
  
  You can make sure that you do not lose data from services running on the source machine. You can select the services that you want to stop before Converter Standalone synchronizes the data between the source and destination machine. As a result, the services do not generate data while source and destination machines are synchronized.

- **Synchronize the Destination Machine with Changes Made to the Source Machine** on page 72
  
  When you convert a powered on Windows machine, Converter Standalone copies data from the source machine to the destination machine while the source machine is still running and generating changes. This process is the first transfer of data. You can transfer data for the second time by copying only the changes made during the first transfer of data. This process is called synchronization.

- **Power Off the Source Machine After Conversion** on page 73
  
  If your source machine is running services that you want to start on the destination virtual machine after conversion, you can power off the source machine to avoid interference between source and destination services.

- **Power On the Destination Virtual Machine After Conversion** on page 74
  
  You can minimize the downtime of important services by powering on the destination virtual machine immediately after the conversion is complete.
Limit the Amount of Resources Used by the Conversion Job

A conversion job competes for computing resources with other processes. To limit the impact of the conversion job on other workloads, you can throttle the job. If you do not throttle conversion jobs, they are carried out with normal priority and depending on the available computing resources during conversion.

Uninstall Converter Standalone Agent from the Source Machine

When setting up a conversion job for a powered on Windows source or a Hyper-V Server virtual machine, you can choose how you want to remove the Converter Standalone agent from the source after the conversion. If the Converter Standalone agent is installed by the Converter Standalone server, it is uninstalled automatically. Otherwise, you must uninstall it manually.

Set the Startup Mode for Destination Services

To minimize downtime for a Windows service, you can select the service and set the service startup mode to automatic, manual, or disabled.

You can change the settings for the destination services only when you convert source machines that run Windows.

Prerequisites

On the Options page of the Conversion wizard, click Services in the options list.

Procedure

1. If you are converting a powered on source machine, click the Destination services tab.

   If the source machine is powered off, the Services pane displays no tabs. You can modify only the starting mode of destination services.

2. On the services list, select the startup mode for each service.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Automatic</td>
<td>The service starts automatically after the destination machine is powered on.</td>
</tr>
<tr>
<td>Manual</td>
<td>The service does not start after the destination machine is powered on, but you can start it manually.</td>
</tr>
<tr>
<td>Disabled</td>
<td>The service is disabled and does not start after the destination machine is powered on.</td>
</tr>
</tbody>
</table>

3. Save your settings.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select another option from the options list</td>
<td>Saves your settings and displays the pane for the selected option.</td>
</tr>
<tr>
<td>Click Next</td>
<td>Saves your settings and displays the next page of the Conversion wizard.</td>
</tr>
<tr>
<td></td>
<td>- The Customizations page is displayed if you select Customize guest preferences for the virtual machine in the Advanced options pane.</td>
</tr>
<tr>
<td></td>
<td>- The Summary page is displayed if you do not select Customize guest preferences for the virtual machine in the Advanced options pane.</td>
</tr>
</tbody>
</table>
Stop Services Running on the Source Machine

You can make sure that you do not lose data from services running on the source machine. You can select the services that you want to stop before Converter Standalone synchronizes the data between the source and destination machine. As a result, the services do not generate data while source and destination machines are synchronized.

You can stop services on the source only when you convert a powered on Windows machine.

**Prerequisites**

On the Options page of the Conversion wizard, click Services in the options list.

**Procedure**

1. Click the **Source services** tab.
2. To stop a service on the source machine before synchronization, highlight a service and select the **Stop** check box to the right.
3. Save your settings.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select another option from the options list</td>
<td>Saves your settings and displays the pane for the selected option.</td>
</tr>
<tr>
<td><strong>Click Next</strong></td>
<td>Saves your settings and displays the next page of the Conversion wizard.</td>
</tr>
<tr>
<td></td>
<td>- The Customizations page is displayed if you select <strong>Customize guest preferences for the virtual machine</strong> in the Advanced options pane.</td>
</tr>
<tr>
<td></td>
<td>- The Summary page is displayed if you do not select <strong>Customize guest preferences for the virtual machine</strong> in the Advanced options pane.</td>
</tr>
</tbody>
</table>

Converter Standalone stops the selected source services before it synchronizes the destination machine with the source machine.

**Synchronize the Destination Machine with Changes Made to the Source Machine**

When you convert a powered on Windows machine, Converter Standalone copies data from the source machine to the destination machine while the source machine is still running and generating changes. This process is the first transfer of data. You can transfer data for the second time by copying only the changes made during the first transfer of data. This process is called synchronization.

Synchronization is available only for Windows source operating systems and managed destinations.

If you resize FAT volumes or shrink NTFS volumes, or change the cluster size on the destination volume, you cannot use the synchronization option.

You cannot add or remove volumes on the source machine between two cloning tasks of a synchronizable job because it might cause conversion to fail.

**Prerequisites**

Stop various source services to make sure they do not generate additional changes during the final synchronization, as that might lead to data loss.

On the Options page of the Conversion wizard, click Advanced options in the options list.

**Procedure**

1. Click the **Synchronize** tab.
2 Select **Synchronize changes**.

3 Specify when you want to perform the synchronization.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Click Run immediately after cloning</td>
<td>Synchronization is performed immediately after the cloning is complete.</td>
</tr>
<tr>
<td>Click Schedule</td>
<td>Synchronization is performed at the scheduled time and date. Use the <strong>Run</strong> at text box to specify the start date and time for the synchronization.</td>
</tr>
</tbody>
</table>

4 Select **Perform final synchronization** if you do not plan to make further synchronizations between the source and the destination.

5 Save your settings.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select another option from the options list</td>
<td>Saves your settings and displays the pane for the selected option.</td>
</tr>
<tr>
<td>Click Next</td>
<td>Saves your settings and displays the next page of the Conversion wizard.</td>
</tr>
<tr>
<td></td>
<td>■ The Customizations page is displayed if you select <strong>Customize guest preferences for the virtual machine</strong> in the Advanced options pane.</td>
</tr>
<tr>
<td></td>
<td>■ The Summary page is displayed if you do not select <strong>Customize guest preferences for the virtual machine</strong> in the Advanced options pane.</td>
</tr>
</tbody>
</table>

### Power Off the Source Machine After Conversion

If your source machine is running services that you want to start on the destination virtual machine after conversion, you can power off the source machine to avoid interference between source and destination services.

**Prerequisites**

On the Options page of the Conversion wizard, click **Advanced options** in the options list.

**Procedure**

1 Click the **Post-conversion** tab.

2 In the **Post-conversion power state** panel, select **Power off source machine**.

   This option appears in the **Post-conversion power state** panel only if the conversion source is a remote powered on machine.

3 Save your settings.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select another option from the options list</td>
<td>Saves your settings and displays the pane for the selected option.</td>
</tr>
<tr>
<td>Click Next</td>
<td>Saves your settings and displays the next page of the Conversion wizard.</td>
</tr>
<tr>
<td></td>
<td>■ The Customizations page is displayed if you select <strong>Customize guest preferences for the virtual machine</strong> in the Advanced options pane.</td>
</tr>
<tr>
<td></td>
<td>■ The Summary page is displayed if you do not select <strong>Customize guest preferences for the virtual machine</strong> in the Advanced options pane.</td>
</tr>
</tbody>
</table>

Converter Standalone powers off the source machine after the conversion is complete.
Power On the Destination Virtual Machine After Conversion

You can minimize the downtime of important services by powering on the destination virtual machine immediately after the conversion is complete.

Prerequisites

On the Options page of the Conversion wizard, click Advanced options in the options list.

Procedure

1. Click the Post-conversion tab.
2. In the Post-conversion power state panel, select Power on destination machine.
3. Save your settings.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select another option from the options list</td>
<td>Saves your settings and displays the pane for the selected option.</td>
</tr>
<tr>
<td>Click Next</td>
<td>Saves your settings and displays the next page of the Conversion wizard.</td>
</tr>
<tr>
<td></td>
<td>■ The Customizations page is displayed if you select Customize guest preferences for the virtual machine in the Advanced options pane.</td>
</tr>
<tr>
<td></td>
<td>■ The Summary page is displayed if you do not select Customize guest preferences for the virtual machine in the Advanced options pane.</td>
</tr>
</tbody>
</table>

After the conversion, Converter Standalone powers on the destination machine.

Limit the Amount of Resources Used by the Conversion Job

A conversion job competes for computing resources with other processes. To limit the impact of the conversion job on other workloads, you can throttle the job. If you do not throttle conversion jobs, they are carried out with normal priority and depending on the available computing resources during conversion.

A powered on source machine runs its own conversion job. You can limit the impact of the conversion job on other workloads running on the powered on machine.

For source machines that are not powered on, you can limit the resources used on the machine where Converter Standalone server is installed.

Throttling controls the CPU and network resources that the conversion process uses. You cannot throttle disk I/O from the Converter Standalone interface, but can throttle it indirectly by throttling the network bandwidth.

**Note** You cannot throttle conversion jobs for powered on source machines that run Linux. You cannot throttle conversion jobs for powered off virtual machines to VMware hosted destinations.

Procedure

1. On the Options page, select Throttling from the options list.
2 From the **CPU throttling** drop-down menu, select the priority of the conversion task.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td>The priority of the current conversion task is set to normal.</td>
</tr>
<tr>
<td>Light</td>
<td>The priority of the current conversion task is reduced slightly below normal.</td>
</tr>
<tr>
<td>Medium</td>
<td>The priority of the current conversion task is set to lowest.</td>
</tr>
</tbody>
</table>

**Note**: Converter Standalone reduces the thread priorities of conversion tasks to control the CPU resources they consume.

3 (Optional) Select **Network bandwidth throttling** and specify the maximum network bandwidth at which Converter Standalone performs the conversion jobs.

4 Save your settings.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select another option from the options list</td>
<td>Saves your settings and displays the pane for the selected option.</td>
</tr>
<tr>
<td>Click Next</td>
<td>Saves your settings and displays the next page of the Conversion wizard.</td>
</tr>
<tr>
<td></td>
<td>- The Customizations page is displayed if you select <strong>Customize guest preferences for the virtual machine</strong> in the Advanced options pane.</td>
</tr>
<tr>
<td></td>
<td>- The Summary page is displayed if you do not select <strong>Customize guest preferences for the virtual machine</strong> in the Advanced options pane.</td>
</tr>
</tbody>
</table>

### Uninstall Converter Standalone Agent from the Source Machine

When setting up a conversion job for a powered on Windows source or a Hyper-V Server virtual machine, you can choose how you want to remove the Converter Standalone agent from the source after the conversion. If the Converter Standalone agent is installed by the Converter Standalone server, it is uninstalled automatically. Otherwise, you must uninstall it manually.

Use Add or Remove Programs on the source machine to uninstall the Converter Standalone agent.

**Procedure**

1 In Windows, run **Add or Remove Programs**.
2 In the list of installed programs, locate and click **VMware vCenter Converter Standalone Agent**.
3 Click **Remove**.
4 In the confirmation dialog box, click **Yes**.

Windows installer uninstalls the Converter Standalone agent from the source machine.

### Review the Summary and Submit the Conversion Job

On the Summary page, you can view a summary of the conversion job before you add it to the job list.

The summary includes information about the source machine, the destination virtual machine, and destination customization settings (if any). Converter Standalone performs job validation at this stage.

**Prerequisites**

You must complete all steps in the Conversion wizard to access the Summary page.

**Procedure**

1 Review the summary of the job.
2 Click **Finish** to submit the job.

Converter Standalone validates the job parameters. This might take several minutes. If the validation succeeds, the conversion job appears in the Job View list in the main application window. You can find information about the tasks of the job in the Task View. If the validation fails, you must click **Back** and correct the invalid parameters as prompted.
Configure Virtual Machines

You might need to configure a virtual machine after you convert it so that it is ready to start in the destination virtual environment. You might also need to configure virtual machines if their virtual environment changes or if you need to improve their performance.

**Note** You can configure only VMware virtual machines that run Windows. You cannot configure virtual machines that run operating systems other than Windows.

Unlike the conversion process, which is nondestructive to the source machine, the configuration process affects the source. When you create a configuration job, your settings are applied to the configuration source machine and cannot be reverted.

**Procedure**

1. **Start the Configuration Wizard** on page 77
   You can configure VMware desktop virtual machines or virtual machines managed by ESXi hosts or vCenter Server.

2. **Select a Source Machine to Configure** on page 78
   You can select a powered off VMware virtual machine as the source for a configuration task.

3. **Select the Options to Configure** on page 80
   When you create a configuration job, you can select the steps of the configuration process that you want to run.

4. **Review and Submit the Configuration Job** on page 85
   After you review your settings on the Summary page of the Configuration wizard, you can go back and change a setting or submit the job.

**Start the Configuration Wizard**

You can configure VMware desktop virtual machines or virtual machines managed by ESXi hosts or vCenter Server.

A powered on machine cannot be a configuration source.

You can configure only powered off virtual machines.

**Procedure**

1. Start the VMware vCenter Converter Standalone application.

2. Click **Configure machine** in the application menu.

The Configuration wizard opens.
What to do next
Select the source machine to configure.

Select a Source Machine to Configure
You can select a powered off VMware virtual machine as the source for a configuration task.

Procedure
◆ On the Source System page of the Configuration wizard, select a source type from the drop-down menu.

What to do next
On the Options page of the Configuration wizard, you can select the required configuration options.

Select a vSphere Virtual Machine to Configure
You can configure vSphere virtual machines. A vSphere virtual machine is a virtual machine that runs on an ESX host or on an ESX host managed by vCenter Server.

Prerequisites
Power off the source machine before the configuration.

In the main application window of Converter Standalone, click Configure machine to open the Configuration wizard.

Procedure
1 On the Source System page of the Configuration wizard, select VMware Infrastructure virtual machine from the Select source type drop-down menu.
2 Provide the IP address or host name and credentials for authentication with the ESX host or the vCenter Server, and click Next.

The Source Machine page appears, displaying the host name or IP address and the inventory of the ESX host or the vCenter Server.

What to do next
On the Source Machine page of the Configuration wizard you can browse the virtual infrastructure inventory and select the virtual machine to configure.

Specify the vCenter Server Virtual Machine to Configure
If you choose to configure a virtual machine managed by a vCenter Server or ESXi host, you must browse the inventory to locate the source virtual machine.

Prerequisites
On the Source System page of the Configuration wizard, select VMware Infrastructure virtual machine as the configuration source and click Next to proceed to the Source Machine page.
Procedure

1  (Optional) If you are connected to a vCenter Server, select a virtual machine view from the Specify machine with drop-down menu.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hosts and Clusters</td>
<td>The Inventory tree pane provides a view of hosts, clusters, resource pools, and vApps. If you select a host managed by a cluster, you see the full list of virtual machines and templates in the virtual machine list view. If you select a standalone host or a cluster, you see only the virtual machines that are not deployed in the resource pools of that host or cluster.</td>
</tr>
<tr>
<td>VMs and Templates</td>
<td>The Inventory tree pane provides a view of datacenters and virtual machine folders.</td>
</tr>
</tbody>
</table>

2  (Optional) If you are connected to a vCenter Server, select an object from the Inventory tree pane.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hosts and Clusters</td>
<td>Select cluster, ESX host, resource pool, or vApp.</td>
</tr>
<tr>
<td>VMs and Templates</td>
<td>Select datacenter or virtual machine folder.</td>
</tr>
</tbody>
</table>

3  From the virtual machines list, select the virtual machine you want to configure.

You can search for virtual machines in the virtual machine list by typing one or more letters of their names in the Search for name with text box. You can clear your search by clicking Clear.

**NOTE** You cannot select a virtual machine from an ESX host that is powered off, connected to another vCenter Server, or in maintenance mode.

4  (Optional) To refresh the inventory, click Refresh.

5  (Optional) To view more details about a machine, select it and click View source details.

6  Click Next to proceed to the Options page.

What to do next

On the Options page of the Configuration wizard, you can select the required configuration options.

Select a VMware Desktop Virtual Machine to Configure

You can configure standalone VMware virtual machines created with VMware Workstation, VMware Fusion, or VMware Player.

**Prerequisites**

If you plan to use a network path to locate the source, verify that the machine where Converter Standalone server runs has access to that network path.

In the main application window of Converter Standalone, click Configure machine to open the Configuration wizard.

**Procedure**

1  On the Source System page of the Configuration wizard, select VMware Workstation or other VMware virtual machine.
2  Locate the virtual machine source.
   - If you are connected to a remote Converter Standalone server, provide a network path to the source virtual machine file (.vmx) in the Virtual machine file text box. For example, \server\virtual_machines\virtual_machine.vmx.
   - If you are connected to a local Converter Standalone server, provide a network path or a local path to the .vmx file.

By default, only VMware virtual machine *.vmx files are displayed.

3  If you are connected to a remote Converter Standalone server, type user credentials for accessing the source virtual machine.

You do not have to provide user credentials if you are connected to a local Converter Standalone server. In such cases, Converter Standalone uses the Windows credentials to connect to the source machine.

4  (Optional) To view more information about the selected source, click View source details.

5  Click Next to proceed to the Options page.

What to do next
On the Options page of the Configuration wizard, you can select the required configuration options.

Select the Options to Configure

When you create a configuration job, you can select the steps of the configuration process that you want to run.

Procedure

◆ On the Options page, select one or more configuration steps to perform and click Next.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Install VMware Tools on the destination virtual machine</td>
<td>Installs VMware Tools to enhance the performance of the destination virtual machine.</td>
</tr>
<tr>
<td>Customize guest preferences for the virtual machine</td>
<td>Lets you customize Windows guest operating systems so that you can prevent and resolve licensing and networking issues.</td>
</tr>
<tr>
<td>Remove System Restore checkpoints on destination</td>
<td>Removes System Restore checkpoints from the destination virtual machine.</td>
</tr>
<tr>
<td>Reconfigure destination virtual machine</td>
<td>Modifies the configuration of the virtual machine so that it is prepared to boot and work properly in the destination virtual environment.</td>
</tr>
</tbody>
</table>

What to do next
On the basis of the configuration options you selected, you can either customize the guest operating system of the source virtual machine or view the Summary page of the Configuration wizard.

Install VMware Tools on a Virtual Machine

Install VMware Tools to improve graphics performance for the guest operating system of a configured virtual machine. Other enhancements include automatic grab and release of the mouse pointer, copying and pasting between guest and host, improved mouse performance, and so on.

Install VMware Tools on the virtual machine you are configuring.

Procedure

◆ On the Options page of the Configuration wizard, select Install VMware Tools on the destination virtual machine and click Next.
vCenter Converter Standalone installs VMware Tools on the configured virtual machine.

**What to do next**
You can customize the guest operating system or view the Summary page of the Configuration wizard.

**Customize the Windows Guest Operating System**
As a part of the configuration job, you can customize virtual machines running Windows.

**Prerequisites**
- On the Options page of the Configuration wizard, select **Customize guest preferences for the virtual machine** and click Next to view and modify the available customization options.
- **Customize the Identity of a Virtual Machine** on page 81
  To configure the identity of a virtual machine on a virtual network, personalize the virtual machine by editing its name, owner, and organization name, and by generating a new security ID.
- **Specify the Windows License Information** on page 82
  Ensure that you provide licensing information for all destination virtual machines running guest operating systems as necessary. Because of third-party licensing policies, you might not be able to transfer the license from the source machine and you might need to provide a new valid license for the destination virtual machine.
- **Set the Time Zone** on page 83
  You can configure the time zone for a virtual machine.
- **Configure the Network Adapters** on page 83
  You can change the network settings of a virtual machine to work with the network configuration of the virtual environment.
- **Assign a Workgroup or Domain Details** on page 84
  You can configure the workgroup and the domain for a virtual machine.

**Customize the Identity of a Virtual Machine**
To configure the identity of a virtual machine on a virtual network, personalize the virtual machine by editing its name, owner, and organization name, and by generating a new security ID.

**Prerequisites**
On the Options page of the Configuration wizard, select **Customize guest preferences for the virtual machine** and click Next to view and modify the available customization options.

**Procedure**
1. On the Customizations page, select **Computer information** from the options list.
2 Customize the guest operating system identity.
   a In the **Computer Name** text box, type a computer name to identify the virtual machine on the network.
      Valid characters include A-Z, a-z, 0-9, and the hyphen (-). The underscore (_) is nonstandard, but Converter Standalone permits it. The recommended length for most languages is 15 characters or less. Computer names cannot consist only of numerals.
   b In the **Owner Name** text box, type the name of the owner of the virtual machine.
      Valid characters include A-Z, a-z, 0-9, and the hyphen (-). The underscore (_) is nonstandard, but Converter Standalone permits it. The owner name cannot have more than 63 characters or consist only of numerals.
   c In the **Organization** text box, type an organization name.
      Valid characters include all printable characters (A-Z, a-z, 0-9, symbols, and space). The limit is 63 characters.

3 (Optional) To create a new security identifier, select **Generate New Security ID (SID)**.
   By default, the **Generate New Security ID (SID)** check box is selected for source systems that run Windows Vista or later and cannot be deselected.

The identifiers of the configured virtual machine are assigned according to your settings.

**What to do next**
You can select another option to set or click Next to view a summary of the configuration job. If the Next button is inactive, check the Current settings list for other settings that need your attention on this page.

**Specify the Windows License Information**
Ensure that you provide licensing information for all destination virtual machines running guest operating systems as necessary. Because of third-party licensing policies, you might not be able to transfer the license from the source machine and you might need to provide a new valid license for the destination virtual machine.

**Prerequisites**
On the Options page of the Configuration wizard, select **Customize guest preferences for the virtual machine** and click Next to view and modify the available customization options.

**Procedure**
1 On the Customizations page, select **Windows license** from the options list.
2 In the **Product ID** text box, type the licensing information for the destination virtual machine.
3 (Optional) If the guest operating system is Windows Server 2008, select **Include server license information**.
4 Select a **Server license mode** option.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Per seat</td>
<td>For individual user licenses.</td>
</tr>
<tr>
<td>Per server</td>
<td>For a concurrent user license. When you select this option, you need to</td>
</tr>
<tr>
<td></td>
<td>type a value in the <strong>Maximum connections</strong> text box.</td>
</tr>
</tbody>
</table>

The Windows license information is saved to the configuration source machine when the configuration task is completed.
What to do next

You can select another option to set or click Next to view a summary of the configuration job. If the Next button is inactive, check the Current settings list for other settings that need your attention on this page.

Set the Time Zone

You can configure the time zone for a virtual machine.

Prerequisites

On the Options page of the Configuration wizard, select Customize guest preferences for the virtual machine and click Next to view and modify the available customization options.

Procedure

1 On the Customizations page, select Time zone from the options list.
2 Select the target time zone from the Time zone drop-down menu.

The time zone is set on the destination machine when the configuration job completes.

What to do next

You can select another option to set or click Next to view a summary of the configuration job. If the Next button is inactive, check the Current settings list for other settings that need your attention on this page.

Configure the Network Adapters

You can change the network settings of a virtual machine to work with the network configuration of the virtual environment.

The options for configuring network adapters are available for all supported customization sources.

Prerequisites

On the Options page of the Configuration wizard, select Customize guest preferences for the virtual machine and click Next to view and modify the available customization options.

Procedure

1 On the Customizations page, select Network interface settings from the options list.
2 Select a network adapter and click Customize to configure its properties.
   a On the IPv4 tab, type the IPv4 address and DNS server address.
   b On the IPv6 tab, type the IPv6 address and DNS server address.
   c On the DNS tab, configure the DNS connections by adding DNS suffixes.
   d Type a DNS suffix and click Add.

You can add more than one DNS suffix.

   e If you have provided multiple DNS suffixes, use Move up and Move down to set the order in which the guest operating system uses the connections.
   f On the WINS tab, type the primary and secondary WINS IPv4 address in the text box.

When powered on, the configured virtual machine uses the network settings that you specified.

What to do next

You can select another option to set or click Next to view a summary of the configuration job. If the Next button is inactive, check the Current settings list for other settings that need your attention on this page.
Assign a Workgroup or Domain Details

You can configure the workgroup and the domain for a virtual machine.

Prerequisites

On the Options page of the Configuration wizard, select **Customize guest preferences for the virtual machine** and click **Next** to view and modify the available customization options.

Procedure

1. On the Customizations page, select **Workgroup/Domain** from the options list.
2. Select how the virtual machine participates in the destination network.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Workgroup</td>
<td>The text box must have a value. Valid characters include A-Z, a-z, 0-9, space, and the hyphen (-). The maximum length is 15 characters.</td>
</tr>
<tr>
<td>Windows server domain</td>
<td>The text box must have a value. Valid characters include A-Z, a-z, 0-9, space, period, and the hyphen (-). The maximum length is 64 characters. User credentials are required.</td>
</tr>
</tbody>
</table>

The configured virtual machine connects to the specified workgroup and domain server.

What to do next

You can select another option to set or click **Next** to view a summary of the configuration job. If the **Next** button is inactive, check the Current settings list for other settings that need your attention on this page.

Remove System Restore Checkpoints

Remove the System Restore checkpoints of newly imported source machines to prevent them from reverting to a preconversion state. For other configuration source machines, removing System Restore checkpoints helps you save disk space by deleting unnecessary data.

Procedure

- On the Options page of the Configuration wizard, select **Remove System Restore checkpoints on the destination** and click **Next**.

The System Restore checkpoints are deleted from the configuration source machine.

What to do next

You can customize the guest operating system or view the Summary page of the Configuration wizard.

Reconfiguring a Virtual Machine To Boot Properly

If a newly converted virtual machine does not start properly in the destination virtual environment, try reconfiguring it with Converter Standalone.

Problem

A number of configuration issues might prevent a newly created virtual machine from starting properly. For example, Converter Standalone might need to disable some legacy drivers to allow the virtual machine to operate. If the operating system on the source machine is not on the default drive, the boot.ini file or the BCD might need to be modified so that the destination virtual machine can start.
Solution

On the Options page of the Configuration wizard, select **Reconfigure destination virtual machine** and click **Next**.

Converter Standalone reconfigures the destination virtual machine so it can boot in the virtual environment.

**What to do next**

You can customize the guest operating system or view the Summary page of the Configuration wizard.

**Review and Submit the Configuration Job**

After you review your settings on the Summary page of the Configuration wizard, you can go back and change a setting or submit the job.

**Procedure**

1. Review the summary of the settings for the source virtual machine.
2. Click **Finish** to submit the configuration job.

The job appears in the jobs list in the Job View list of the main application window. You can view the progress of the current task on the **Task progress** tab in Task View.

**What to do next**

To view details about the configuration task, click the **Summary** tab.
Converter Standalone provides a manager for managing conversion and configuration jobs and tasks.

After you create a conversion or configuration job by using the Converter Standalone wizards, you can use the Task View and the Job View of the Converter Standalone manager to monitor and manage the existing jobs and their tasks.

Scheduled synchronized conversion jobs can contain multiple tasks.

This chapter includes the following topics:

- “Manage Jobs in the Job List,” on page 87
- “Manage Tasks in the Task List,” on page 91
- “Verify Jobs and Tasks Progress and the Log Files,” on page 94

Manage Jobs in the Job List

The Job View of the Converter Standalone manager provides a list of all jobs that are submitted. You can use the main application menus to control the way jobs appear in the job list and to edit them.

Prerequisites

You must submit a conversion or configuration job to view it in the job list.

You must be in the Job View of the Converter Standalone manager to access the application menus for job managing.

- Add a Job to the Job List on page 88
  Converter Standalone allows you to create and run conversion and configuration jobs.

- View the Running Task of a Job on page 88
  You can switch from Job View to Task View to view and edit the currently running task of a job.

- Deactivate a Job on page 88
  You can deactivate an active job without applying any changes to the destination machine.

- Delete a Job on page 89
  You can delete a job and all its tasks.

- Create a Job by Copying an Existing Job on page 89
  You can create a new job by creating a copy of an existing job and modifying its settings in the Conversion or the Configuration wizard. The settings for the original job appear at each step of the wizard so that you can reuse or change them.
Add a Job to the Job List

Converter Standalone allows you to create and run conversion and configuration jobs.

Procedure

- On the Summary page of the Conversion or the Configuration wizard, make sure no settings need adjustment, and click **Finish** to add a conversion or configuration job.

The job appears at the beginning of the job list in the Job View and its tasks appear in the Task View.

What to do next

In the job list, you can view the job status, which task of the job is currently running, and other details. You can also delete a job, and perform other job operations.

View the Running Task of a Job

You can switch from Job View to Task View to view and edit the currently running task of a job.

Procedure

1. From the **View by** drop-down menu on the toolbar, select **Jobs**.
2. From the job list, select a job.
3. On the main menu, select **Job > Go to running task**.

The Converter Standalone manager switches to Task View and preselects the currently running task of the job you selected in Job View. If none of the job’s tasks is running, no selection is made.

Deactivate a Job

You can deactivate an active job without applying any changes to the destination machine.

Prerequisites

**Note** You can deactivate a job only if none of its tasks is currently running.

Procedure

1. From the **View by** drop-down menu on the toolbar, select **Jobs**.
2. From the job list, select the job you want to deactivate.
3. From the main menu, select **Job > Deactivate**.

The job state changes to inactive and no changes are applied to the destination.

**Note** An inactive job cannot be reactivated.
Delete a Job
You can delete a job and all its tasks.

Prerequisites
You can delete only deactivated jobs.

Procedure
1. From the View by drop-down menu on the toolbar, select Jobs.
2. From the job list, select the job you want to delete.
3. From the main menu, select Job > Delete.

The job is removed from the job list, and all the tasks of the job are removed from the task list.

Create a Job by Copying an Existing Job
You can create a new job by creating a copy of an existing job and modifying its settings in the Conversion or the Configuration wizard. The settings for the original job appear at each step of the wizard so that you can reuse or change them.

Note: You can copy only jobs that were created with the Converter Standalone client.

Procedure
1. From the View by drop-down menu on the toolbar, select Jobs.
2. From the job list, select the job you want to copy.
3. Select Job > Copy As New.
4. Follow the prompts to modify the job settings.
5. Click Finish to add the new job to the job list.

Filter the Jobs in the Jobs List
You can select the jobs that you want the job list to display by filtering them.

You can filter jobs by history, status, or multiple criteria.

- Filter Jobs by History on page 90
  You can filter the list so that it displays only the last submitted jobs. By default, the job list displays the last twenty jobs.

- Filter Jobs by Status on page 90
  You can filter the job list to display jobs based on their status: Active, Inactive, and All. Active jobs include all running, scheduled, and not scheduled jobs. By default, the job list displays all jobs.

- Filter Jobs by Multiple Criteria on page 90
  You can combine filtering criteria to filter jobs in the job list.
Filter Jobs by History
You can filter the list so that it displays only the last submitted jobs. By default, the job list displays the last twenty jobs.

Procedure
1. From the View by drop-down menu on the toolbar, select Jobs.
2. On the main menu, click View > History Filter and select a level of filtering.

Only jobs that correspond to selected filtering level remain in the job list.

Filter Jobs by Status
You can filter the job list to display jobs based on their status: Active, Inactive, and All. Active jobs include all running, scheduled, and not scheduled jobs. By default, the job list displays all jobs.

Procedure
1. From the View by drop-down menu on the toolbar, select Jobs.
2. On the main menu, select View > Filter by.
3. Select a level of display from the drop-down menu.
   If you are connected to a remote Converter Standalone server, you can select My own to view only jobs that you have created.

Filter Jobs by Multiple Criteria
You can combine filtering criteria to filter jobs in the job list.

Procedure
1. From the View by drop-down menu on the toolbar, select Jobs.
2. Use the drop-down menus in the toolbar to select the status and the history criteria.
   The two filtering conditions combine to show only jobs that comply with both conditions.

Add a Synchronization Task to a Conversion Job
You can add a synchronization task to an active conversion job and modify the synchronization settings in the Conversion wizard.

Note: You can add synchronization tasks only to jobs that were created with the Converter Standalone client.

Prerequisites
The conversion job must be active and allow synchronization.
No synchronization task that belongs to this job must be running.

Procedure
1. From the View by drop-down menu on the toolbar, select Jobs.
2. From the job list, select the conversion job to which you want to add a synchronization task.
3. From the main menu, select Job > Synchronize.
4. Follow the prompts to modify the synchronization settings.
5 Click **Finish** to save changes.

### Manage Tasks in the Task List

The Task View of the Converter Standalone manager provides a list of all tasks that are submitted. You can use the main application menus to control the way tasks appear in the task list and to edit them.

**Prerequisites**

You must submit a conversion or configuration job to view its tasks in the task list.

You must be in the Tasks View of the Converter Standalone manager to access the application menus for managing task.

- **Control the Number of Tasks Running Concurrently** on page 91
  
  You can set the number of tasks that can run concurrently to improve the conversion speed. Limiting the number of concurrent tasks helps you reduce the network resources required for the conversion tasks. Limiting the number of concurrent tasks also helps to limit the CPU load on the machine where the Converter Standalone server runs.

- **Set the Number of Data Connections per Task** on page 92
  
  If you are converting sources with multiple disks and volumes, you can decrease the conversion time by cloning multiple disks and volumes concurrently. This option is supported for conversions of Windows sources and Linux virtual sources.

- **View the Job to Which a Task Belongs** on page 92
  
  You can switch from Task View to Job View to view and edit the job to which a selected task belongs.

- **Cancel a Task** on page 93
  
  You can cancel a task that is in the queue or in progress.

- **Filter the Tasks in the Task List** on page 93
  
  The number of archived tasks can grow to be very large. To minimize clutter in the task list, you can lower the number of tasks that appear. You can select the tasks that you want the task list to display by filtering them.

### Control the Number of Tasks Running Concurrently

You can set the number of tasks that can run concurrently to improve the conversion speed. Limiting the number of concurrent tasks helps you reduce the network resources required for the conversion tasks. Limiting the number of concurrent tasks also helps to limit the CPU load on the machine where the Converter Standalone server runs.

You can set the number of concurrent tasks to any number from 1 to 12. The default number of concurrent tasks is set to **Maximum**.

**Procedure**

1. On the main menu, select **Administration > Maximum Concurrent Tasks**.
2. In the **Custom** spin-box, specify a number.
3. Click **OK**.

The setting takes effect immediately for all newly added tasks. See “**Example: Limiting the Number of Concurrent Tasks**,” on page 92.
Example: Limiting the Number of Concurrent Tasks

Assume that Converter Standalone is running 12 tasks. If you change the number of concurrent tasks to 6, these 12 tasks continue running, but all newly added tasks remain pending in the task list. When the number of running tasks drops to 5, a new task from the wait list starts.

Set the Number of Data Connections per Task

If you are converting sources with multiple disks and volumes, you can decrease the conversion time by cloning multiple disks and volumes concurrently. This option is supported for conversions of Windows sources and Linux virtual sources.

When you clone multiple disks and volumes in parallel, each data transfer uses a separate TCP connection.

**Note** For managed sources and destinations, the number of the concurrent data connections within a conversion task must not exceed the TCP connections limit of the corresponding ESXi host. Otherwise, the conversion task might not complete successfully.

The source conversion completes and the task of configuring the destination starts only when all data transfers are complete.

**Procedure**

1. On the main menu, select **Administration > Data Connections per Task**.
2. Select the number of concurrent data connections.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Select the Maximum check-box</strong></td>
<td>All disks and volumes of the source are cloned simultaneously.</td>
</tr>
<tr>
<td><strong>In the Custom spin-box, select a number between 1 and 12.</strong></td>
<td>Only a specific number of disks and volumes are cloned simultaneously. The default number of concurrent data connections per task is set to 1.</td>
</tr>
</tbody>
</table>

3. Click **OK**.  
The setting takes effect immediately for all newly added tasks.

View the Job to Which a Task Belongs

You can switch from Task View to Job View to view and edit the job to which a selected task belongs.

**Procedure**

1. From the **View by** drop-down menu on the toolbar, select **Tasks**.
2. From the task list, select a task.
3. On the main menu, select **Task > Go to job**.

The Converter Standalone manager switches to Job View. The job that contains the task you selected in Task View is preselected in the list and complies with the current filter of the Job View.
Cancel a Task

You can cancel a task that is in the queue or in progress.

When you cancel a conversion task that is running, the task is stopped. When you cancel a conversion task that is queued, the task is removed from the queue. When you cancel a task that is not a synchronization task, the job to which the task belongs is deactivated. Canceled tasks cannot be restarted.

**NOTE** You cannot cancel configuration tasks.

**Procedure**

1. From the **View by** drop-down menu on the toolbar, select **Tasks**.
2. From the task list, select the task you want to cancel.
3. Click **Cancel**.

The task is now stopped or removed from the queue, and the time of cancellation appears in the End Time column.

Filter the Tasks in the Task List

The number of archived tasks can grow to be very large. To minimize clutter in the task list, you can lower the number of tasks that appear. You can select the tasks that you want the task list to display by filtering them.

You can filter tasks by history, status, or multiple criteria.

- **Filter Tasks by History** on page 93
  You can use the date on which a task is created to filter the task list.
- **Filter Tasks by Status** on page 93
  You can change which tasks appear in the task list based on their running status.
- **Filter Tasks by Multiple Criteria** on page 94
  You can combine filtering criteria to filter tasks in the task list. Tasks that are currently running are displayed regardless of the filtering criteria you apply.

Filter Tasks by History

You can use the date on which a task is created to filter the task list.

This option does not affect tasks in progress. Tasks in progress always appear in the task list.

**Procedure**

1. From the **View by** drop-down menu on the toolbar, select **Tasks**.
2. On the main menu, click **View > History Filter** and select a level of filtering.

Only tasks that correspond to the selected filtering level remain in the task list.

Filter Tasks by Status

You can change which tasks appear in the task list based on their running status.

**Procedure**

1. From the **View by** drop-down menu on the toolbar, select **Tasks**.
2. On the main menu, select **View > Filter by**.
3 Select a level of display from the drop-down menu.
   If you are connected to a remote Converter Standalone server, you can select My own to view only tasks of jobs that you create.

**Filter Tasks by Multiple Criteria**
You can combine filtering criteria to filter tasks in the task list. Tasks that are currently running are displayed regardless of the filtering criteria you apply.

**Procedure**
1. From the View by drop-down menu on the toolbar, select Tasks.
2. Use the drop-down menus to select the status and history criteria.
   The two filtering conditions combine to show only tasks that comply with both conditions.

**Verify Jobs and Tasks Progress and the Log Files**
The Task View and Job View of the Converter Standalone manager allows you to observe the progress and the state of the listed jobs and tasks.

If certain problems cause a job or task to fail, you can also review information in the log files.

- **View Task Progress** on page 94
  The Task view and the Details view show the progress of tasks. You can view the estimated time left to the completion of a conversion task in the End Time column.

- **Export the Log Files for a Job** on page 95
  You can review the log files for information about the jobs, or send a copy of log files to VMware technical support. You can export the log files for all jobs in the job list.

- **Export the Log Files for a Task** on page 95
  If any problems cause a task to fail, you can review information about the task in the log files or send a copy of the log files to VMware technical support. You can export the log files for a specific task in the task list.

- **Back-End and Client Log Files Locations** on page 95
  Converter Standalone saves log files as it operates.

**View Task Progress**
The Task view and the Details view show the progress of tasks. You can view the estimated time left to the completion of a conversion task in the End Time column.

You can obtain a general indication of a task's progress by looking at its row in the task list of the Task view. You can view the Task progress tab in the Details view for more information.

**Procedure**
1. From the View by drop-down menu on the toolbar, select Tasks.
2. Select the row in the task list for the task to view.
   The information for that task appears in the Details pane below the tasks list.
3. Click the Task progress tab to view the task status and log highlights.
Export the Log Files for a Job

You can review the log files for information about the jobs, or send a copy of log files to VMware technical support. You can export the log files for all jobs in the job list.

**Procedure**

1. From the View by drop-down menu on the toolbar, select Jobs.
2. Select a job in the job list.
3. On the main menu, select Job > Export Logs.
4. Select a location to which you want to save the files and click Save.

The log files for all tasks of the selected job are saved to the selected location.

Export the Log Files for a Task

If any problems cause a task to fail, you can review information about the task in the log files or send a copy of the log files to VMware technical support. You can export the log files for a specific task in the task list.

**Procedure**

1. From the View by drop-down menu on the toolbar, select Tasks.
2. Select the task in the task list.
3. In the Details pane, click the Task Progress tab.
4. Click Export Logs.
5. Select a location to which you want to save the files and click Save.

The log files for this task are saved to the selected location.

Back-End and Client Log Files Locations

Converter Standalone saves log files as it operates.

*Table 8-1* lists the default locations where log files are saved. You can view the log files or send them to VMware support, if necessary.

These file locations are also the file locations on the remote machine if you are running a remote hot clone. To send these log files from a remote machine to VMware support, you must manually compress and send them.

*Table 8-1. Log Files Locations*

<table>
<thead>
<tr>
<th>Log Files</th>
<th>File Path</th>
</tr>
</thead>
<tbody>
<tr>
<td>Converter Standalone server and agent log files</td>
<td>%ALLUSERSPROFILE%\VMware\VMware vCenter Converter Standalone\</td>
</tr>
<tr>
<td>Converter Standalone client log files</td>
<td>%USERPROFILE%\Local Settings\Application Data\VMware\VMware vCenter Converter Standalone Client\</td>
</tr>
</tbody>
</table>
Index

A
add a disk 55, 56
adding jobs 88
advanced customization
guest operating system 65
installing VMware Tools 69
removing system restore checkpoints 69
synchronizing source and destination 72
agent 10
allocate memory 62
audience 7

C
changing the number of tasks displayed 93
client 10
cloning
disk based 14
disk-based cloning 15
full clones 15
hot, defined 11
linked clones 15
volume based 14
volume-based cloning 14
cloning modes 14
collected information 41
command-line commands 37
components 10
concurrent disk conversions 92
configuration options 80
configuration, submitting job 85
configure the conversion job 70
configure the hardware
allocate memory 62
configure the Helper VM network 64
configure the network settings 64
edit the number of processors 62
edit the number of processors cores 62
edit the number of processors sockets 62
select a disk controller 63
configure the hardware of the destination machine 52
configure the network settings 64
configure the software 65
configuring
domain details 84
guest operating system 81
install VMware tools 80
prepare for booting 84
removing system restore checkpoints 84
selecting a source 78
selecting VMware Fusion source 78
selecting VMware Player source 78
selecting Workstation source 78
time zone 83
workgroup 84
configuring permissions for vCenter users 26
connect to a remote Converter Standalone server 39
controlling the number of concurrent tasks 91
conversion 90
conversion jobs
submitting 75
viewing summary 75
conversion limitations
configuration limitations 31
Linux guest limitations 31
powered on machine limitations 31
virtual machines 31
VSS snapshots 32
Windows guest limitations 31
conversion tasks
managing 87
maximum running 91
starting 44
conversion throttling 74
Conversion wizard, starting 44
conversion, viewing job summary 75
Converter Standalone
installing client in Windows 34
installing in Windows 34
installing server and agent in Windows 34
modifying installation in Windows 37
repairing in Windows 38
converting
existing system images 15
existing virtual machines 15
converting machines 43
converting, powered on machines 72
copy all disks 60
copy disks or volumes
  copy all disks 60
  create an expandable disk on a hosted destination 58
  create an expandable disk on a managed destination 58
  delete a disk 59
  move a disk to a different datastore 57
  move a volume to a different datastore 56
  move a volume to a different virtual disk 55
  resize a volume 53
  skip a volume 54
  create an expandable disk on a hosted destination 58
  create an expandable disk on a managed destination 58
  customer experience improvement 41
  customer experience improvement program 41, 42
  customize the location 50
  customizing
    computing resources 74
    tasks throttling 74
  customizing the guest operating system 65

D
data connections per task 92
data to copy 52, 60
delete a disk 59
delete job 89
destination
  cluster 50
datastore 50
  ESX 50
  ESX host 22
  ESXi 50
  vCenter Server 50
  virtual hardware version 50
  VMware Fusion 22
  VMware Player 22
  vSphere 50
  Workstation 22
destination machine
  folder 50
  naming 50
  power on 74
destination services, startup mode 71
destination setup
  computer information 66
  DNS 68
  domain details 68
  guest operating system 65
  network adapters 68
  SId 66
time zone 67
  Windows license 67
  WINS 68
  workgroup 68
  disable security protocol 40
  disabling 42
disk
  not pre-allocated 24, 58
  split 24
  thick 24
  thin-provisioned 24, 58
disk cloning modes
  disk-based cloning, defined 15
  full clones, defined 15
  linked clones, defined 15
  volume-based cloning, defined 14
disk controller 63
disk types 24
disk-based cloning 14, 15, 57, 58, 60
disks, adding 56
dual boot systems 11
duplicate ID 16

Eedit the number of processors 62
enable security protocol 40
enabling 42
errors, viewing in the log files 95
ESX host
destination 22
source 21
support 21
ESX VM, source 46
exporting
to hosted formats 49, 51
to managed formats 49
exporting a single task log file 95
exporting jobs logs 95

F
feedback 7
filtering jobs 90
filtering jobs by history 90
firmware interfaces, support 20
full clones, defined 15

g
glossary 7
go to job 92
go to running task 88
guest operating system configuration
  computer information 81
  computer information
  DNS 83
  domain 84
  DNS 83
  DNS 83
  DNS 83
  domain 84
  DNS 83
  domain 84
  time zone 83
  Windows license 82
  WINS 83
  workgroup 84
  workgroup 84
  guest operating system customization
  computer information 66
  DNS 68
  network adapters 68
  SID 66
  time zone 67
  Windows license 67
  WINS 68
  workgroup and domain page 68
  guest operating system, configuration 81
  guest operating system, customization 65
  guest operating system, customizing 65
  GUID partition table (GPT) disks 22

H
  Helper VM 64
  hosted VM, source 47
  hosted destinations
    converting to 51
    Fusion 51
    VMware Server 51
    Workstation 51
  hot cloning
    defined 11
    Linux sources 13
    Windows sources 11
  hot cloning, synchronization 72
  Hyper-V
    source 21
    specify machine 49
    Hyper-V Server VM, source 48

I
  importing machines
    configure the hardware 52
    customize the location 50
    select a source machine 44
  install VMware Tools 69, 80
  installation space requirements 25
  installing 33
  installing Converter Standalone, in Windows 34
  installing VMware vCenter Converter
    Standalone, Windows command-line
    installation 36
  introduction 9
  IPng support 25
  IPv6 support 25

J
  job 89
  job copy 89
  job create 89
  job manager, checking tasks progress 94
  jobs 90
  jobs list 88
  jobs, adding 88

L
  linked clones 14
  linked clones, defined 15
  live cloning, See hot cloning
  log files, exporting and viewing 95
  logical volume 57
  logical volume group 57
  logs, location 95
  LVM 57

M
  managing jobs, job view 87
  managing tasks
    canceling 93
    changing the number of tasks displayed 93
    checking task progress 94
    filtering tasks by status 93
    filtering tasks by history 93
    multiple-criteria filtering 94
    task view 87
  master boot record (MBR) disks 22
  maximum number of tasks 91
  Microsoft Virtual PC, source 21
  Microsoft Virtual Server, source 21
  modes of cloning 14
  modifying 37
  move a disk to a different datastore 57
  move a volume to a different datastore 56
  move a volume to a different virtual disk 55

N
  network settings 64
  not pre-allocated disks 58

O
  online cloning, See hot cloning
  operating systems, support 19
optimized partition alignment 60

P
permissions, configuring for vCenter users 26
port requirements 26
power off source machine 73
power on destination machine 74
powered on machine conversion limitations 31
powered on machine, source 44, 45
progress viewing 94

R
reconfiguring, starting the wizard 77
remote Converter Standalone server 39
repairing 37

S
screen resolution requirements 26
select a disk controller 63
selecting configuration sources
VMware Desktop VMs 79
VMware Infrastructure VMs 78
selecting sources
ESX virtual machine 46
hosted virtual machine 47
Hyper-V Server VM 48
Linux powered on machine 45
powered on machine 44
vCenter Server VM 46
Windows powered on machine 44
server 10
services
on destination 71
on source 72
setting up destination
computer information 66
DNS 68
domain details 68
guest operating system 65
network adapters 68
SID 66
time zone 67
Windows license 67
WINS 68
workgroup 68
setting up SID 81
skip a volume 54
snapshots, limitations 32
source machine
power off 73
uninstall Converter Standalone agent 75
source services, stop 72
SSLv3 40

starting
conversion 44
Conversion wizard 44
starting the Reconfiguration wizard 77
stop source services 72
support 7
supported destination types
ESX host 22
vCenter Server 22
virtual appliances 22
VMware Fusion 22
VMware Player 22
Workstation 22
supported firmware interfaces 20
supported operating systems 19
supported source types
ESX support 21
Hyper-V 21
Microsoft Virtual PC support 21
Microsoft Virtual Server support 21
powered-on machines 21
vCenter Server 21
VirtualCenter support 21
VMware Fusion support 21
VMware virtual machines 21
Workstation support 21
Xen 21
switch to jobs view 88, 92
synchronize conversion 90
synchronizing source with destination 72
system images, converting existing 15
system reconfiguration 10
system requirements
installation space requirements 25
supported destination disk types 24
supported firmware interfaces 20
supported operating systems 19
supported source disk types 22
TCP/IP and UDP port requirements 26
Windows operating systems 28

T
task, canceling 93
task manager
combined filtering 94
filtering by multiple criteria 94
filtering tasks by status 93
filtering tasks by history 93
number of concurrent tasks 91
viewing task progress 94
tasks, filtering 93
tasks, managing 91
tasks, submitting configuration 85
TCP/IP and UDP port requirements 26
thin-provisioned destination disks 9
thin-provisioned disk 58
throttling conversion tasks 74
time zone configuration 83
TLS 1.0 40
TLS 1.1 40
TLS 1.2 40
U
uninstall Converter Standalone agent 75
uninstalling 33
uninstalling VMware vCenter Converter Standalone, in Windows 39
V
vCenter Converter
  migration with 9
tasks 9
vCenter permissions 26
vCenter Server, destination 22
vCenter Server support 21
vCenter Server virtual machines 47
vCenter Server VM, source 46
version support 21
viewing a task’s progress 94
viewing conversion job summary 75
viewing the log files 95
virtual hardware
  CPU 16
disk device issues 16
  Ethernet adapter issues 16
  graphics card issues 16
  virtual hardware version 50
virtual disk 55, 56
virtual disk, adding 56
virtual machines
  conversion limitations 31
  converting existing 15
  destination on same network as source 15
VirtualCenter, destination 22
VMware Fusion
  destination 22
  source 21
  support 21
VMware Player
  destination 22
  source 21
  support 21
VMware hosted products support 21
VMware managed products support 21
VMware Tools 69
VMware vCenter Converter Standalone
  command-line installation in Windows 36
  installing remote access in Windows 35
  uninstalling in Windows 39
  volume, supported types 22
  volume cluster size 54
  volume-based cloning 14, 53–56, 58, 59
  volume-based cloning, defined 14
  volume, supported types 14
  volumes, excluding 54
  volumes, moving 56
  volumes, resizing 53
  VSS snapshots limitations 32
W
Windows virtual machines, configuring 77
Windows, checking Windows Firewall blocks 28
worker 10
Workstation
  destination 22
  source 21
  support 21
X
Xen, source 21